
KACE Privilege Manager for Windows 4.4

Administrator Guide



© 2020 Quest Software Inc. ALL RIGHTS RESERVED.
This guide contains proprietary information protected by copyright. The software described in this guide is furnished under a
software license or nondisclosure agreement. This softwaremaybe used or copied only in accordance with the termsof the
applicable agreement. No part of this guidemaybe reproduced or transmitted in any form or byanymeans, electronic or
mechanical, including photocopying and recording for anypurpose other than the purchaser’s personal use without the written
permission of Quest Software Inc.

The information in this document is provided in connection with Quest Software products. No license, expressor implied, by
estoppel or otherwise, to any intellectual property right is granted by this document or in connection with the sale of Quest Software
products. EXCEPT ASSET FORTH IN THETERMSANDCONDITIONSASSPECIFIED IN THELICENSEAGREEMENT FOR
THISPRODUCT, QUEST SOFTWAREASSUMESNOLIABILITYWHATSOEVER ANDDISCLAIMSANYEXPRESS, IMPLIED
OR STATUTORYWARRANTYRELATINGTO ITSPRODUCTS INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTYOF MERCHANTABILITY, FITNESSFOR APARTICULAR PURPOSE, OR NON-INFRINGEMENT. IN NOEVENT
SHALLQUEST SOFTWAREBELIABLEFOR ANYDIRECT, INDIRECT, CONSEQUENTIAL, PUNITIVE, SPECIALOR
INCIDENTALDAMAGES (INCLUDING,WITHOUT LIMITATION, DAMAGESFOR LOSSOF PROFITS, BUSINESS
INTERRUPTIONOR LOSSOF INFORMATION) ARISINGOUT OF THEUSEOR INABILITYTOUSETHISDOCUMENT,
EVEN IF QUEST SOFTWAREHASBEEN ADVISEDOF THEPOSSIBILITYOF SUCHDAMAGES. Quest Softwaremakesno
representationsor warrantieswith respect to the accuracyor completenessof the contents of this document and reserves the right
to make changes to specificationsand product descriptionsat any time without notice. Quest Software doesnot make any
commitment to update the information contained in this document..

If you have anyquestions regarding your potential use of thismaterial, contact:

Quest Software Inc.

Attn: LEGALDept

4 PolarisWay

Aliso Viejo, CA 92656

Refer to our Web site (https://www.quest.com) for regional and international office information.

Patents
Quest Software is proud of our advanced technology. Patents and pending patentsmayapply to this product. For themost current
information about applicable patents for this product, please visit our website at https://www.quest.com/legal.

Trademarks
Quest, the Quest logo, and Join the Innovation are trademarksand registered trademarksof Quest Software Inc. For a complete
list of Quest marks, visit https://www.quest.com/legal/trademark-information.aspx. All other trademarksand registered trademarks
are property of their respective owners.

Legend
CAUTION: A CAUTION icon indicates potential damage to hardware or loss of data if instructions
are not followed.

IMPORTANT, NOTE, TIP,MOBILE, or VIDEO: An information icon indicates supporting information.

Privilege Manager for Windows Administrator Guide
Updated - May 2020
Version - 4.4

https://www.quest.com/
https://www.quest.com/legal
https://www.quest.com/legal/trademark-information.aspx


Contents

About this guide 6

What is Privilege Manager? 7
Editions 7
Components 8
Console 8
Server 8
Client 8

Installing Privilege Manager 9
System requirements 9
Installing the Console 9
Using the ConsoleWindows Installer file 9
Opening the Console 10
Applying a license 10
Viewing GPOs 10
Selecting target domains 10
Installing a second Console 11

Configuring the Server 12
Using the Server ConfigurationWizard 12
Modifying the Server 12
Removing the Server 12

Installing the Client 13
Using the Client Deployment Settings Wizard 13
Using the Client Windows Installer file 13
Using the Group Policy Management Console 14

Upgrading 15
Uninstalling 16

Configuring Client data collection 17
Using the Client Data Collection Settings Wizard 17

Configuring Instant Elevation 19
Using the Instant ElevationWizard 19

Configuring Self-Service Elevation 21
Using the Self-Service Elevation Request Settings Wizard 21
Selecting how users access the request form 22
Customizing Self-Service request email messages 24
Using Self-Service Notifications 25
Using the Self-Service Elevation Request ProcessingWizard 26
Using the Console Email Configuration screen 27

Privilege Manager for Windows 4.4 Administrator Guide 3



Configuring Temporary Session Elevation 29
Using the Temporary Session Elevation PasscodeManager 29

Configuring privileged application discovery 31
Using the Privileged Application Discovery Settings Wizard 31
Processing discovered privileged applications 32
Using the Generate Rules Wizard 33

Deploying rules 34
Using the Create GPOwith Default Rules Wizard (Privilege Elevation Rules only) 35
Using the Group Policy Management Editor 36
Using the Create RuleWizard 37
Getting started 39
Creating file rules 40
Creating folder path rules 42
Creating ActiveX rules 43
Applying ActiveX rules 44

Creating rules forWindows Installer files 45
Creating rules for script files 46
Using Active Directory user groups (Privilege Elevation Rules only) 47
Using Validation Logic 47
Using standard rules 47
Using Validation Logic rules 48

Granting/denying privileges (Privilege Elevation Rules only) 50
Differentiating security levels (Privilege Elevation Rules only) 51

Managing rules 51
Import/Export Rules 52

Testing rules 52

Removing local admin rights 54
Using the Active Directory Users and Computers utility 54
Using the Users with Local Admin Rights screen 54

Reporting 56
Elevation Activity Report 57
Blacklist Activity Report 58
Rule Deployment Report 58
Instant Elevation Report 59
Temporary Session Elevation Request Report 59
Temporary Session Elevation Usage Report 60
Rule Details Report 60
Advanced Policy Settings Report 60
Generating and using reports 61
Using the Applied Filters Wizard 62
Using the Scheduled Reports Details Wizard 62
Using the Resultant Set of Policy Wizard 64

Privilege Manager for Windows 4.4 Administrator Guide 4



Client-side UI customization 65
Language translation fFiles 65

Using Microsoft tools 67

Maintaining a least privileged use environment 68
Processing Self-Service Elevation Requests 68
Using the Console Email Configuration screen 68

Using Group Policy Settings 68

Database Planning 70
PrivilegeManager Database Diagram 71
PrivilegeManager Tables 71
Data Storage Estimates 72
Database hardware and software requirements 73
Auto-Growth 75
How to change auto-growth on SQL Server 2014 76
Initial database size 76
How to change the Initial Size on SQL Server 2014 77

Product Improvement Program 78
How do I participate in the Product Improvement Program?What if I changemy mind? 78
How will the collected information be used? 78
Where is the data being stored? 78
What information is collected? 78
How does the Product Improvement Program work? 79
How long will collected data be stored? 79
Will I receive spam if I participate in the Product Improvement Program? 79
Do I need an Internet connection? 79
Can I see the data that is collected before it is transmitted? 79
How long will my participation in the program last? 79
How is my privacy protected? 79

About us 80
Technical support resources 80

Privilege Manager for Windows 4.4 Administrator Guide 5



1

About this guide
Welcome to the KACE Privilege Manager for Windows Administrator Guide. This guide instructs system
administrators on how to use Privilege Manager. Inside you will find in-depth instructions on how to prepare
your environment for least privileged use, maintain a least privileged environment, run reports, and interface
with Microsoft tools.
For more information, refer to these additional resources:

For system administrators:

l Privilege Manager Quick Start Guide: Learn about the Privilege Manager system requirements and
how to set up the Console, Server, and Client. Also read an overview of the product’s key features and
the wizards that will help you use them.

l Privilege Manager for Windows Console: Find more information on the Getting Started screen under
the Additional Resources tab.

For end users with the Privilege Manager Client service installed on their computers:

l Privilege Manager for Windows User Guide: Learn the basics of using Privilege Manager for Windows,
including how to use Self-Service Elevation, Instant Elevation, and view rules.

Privilege Manager for Windows 4.4 Administrator Guide
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What is Privilege Manager?
Editions
Components

Giving users administrator rights creates security risks but must be weighed against constant help desk calls for
basic operations like updating Adobe Reader, Java, or simply changing the time zone on desktops.
Privilege Manager lets you grant selected privileges to users so they can update their own computers,
reducing help desk calls while maintaining a secure network. By automating user privilege settings, Privilege
Manager keeps users working; this enables you to focus on higher priority tasks, for exceptional resource and
time savings.
As a system administrator, you can use Privilege Manager to elevate and manage user rights quickly and
precisely with validation logic targeting technology. Use privilege Elevation rules from the community, or create
your own rules and allow administrator-level access to specific applications. You can also enable your end
users to request elevated privileges for specific applications through Self-Service and Instant Elevation.

Editions
Privilege Manager is available in the following editions:

l Privilege Manager Community: This edition is free and does not require a license. You can collaborate,
brainstorm new Elevation rules, share rules with other users, and provide bug reports and enhancement
requests to Quest Software.

l Privilege Manager Professional: This edition requires a paid license and includes additional security,
discovery, and reporting capabilities, as well as technical support from Quest Software.

l Privilege Manager Professional Evaluation: This edition is the free 30-day trial period for Privilege
Manager Professional. If you do not buy a license after 30 days, the software will revert to the lesser-
featured Community edition. You won't have the Professional features, but you can keep the Community
edition just for trying Privilege Manager.

When reverting back to the Community edition, you will need to re-save all computer-based Group Policy
object (GPO) rules as user-based. Computer-based rules will no longer work on the client-side once the
trial expires.

Privilege Manager for Windows 4.4 Administrator Guide
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Components
There are three software components included with Privilege Manager: the Console, Server and Client.

Console
The Privilege Manager Console, installed via PAConsole_Pro.msi, is a management application. It is installed
on a domain computer (serveror workstation) and is used to create and manage rules within the Group Policy.
Any user who has permission to edit a GPO can use the Console to set privileges.

Server
The Privilege Manager Server, installed through the Console, is a service which has several functions. It can
deploy the Client, collect and report on data, and discover and process applications that require elevated
privileges.

Client
The Privilege Manager Client, installed through PAClient.msi, is a service that runs on each client computer. It
applies the rules created in the Console by monitoring processes as they are launched on the Client and
elevates or lowers the privileges for processes that are configured to be monitored. This is done by injecting an
administrative token into the process or revoking it.
Microsoft Active Directory and Group Policy are used to distribute Privilege Manager rules to client computers.
Privilege Manager can modify privileges only for a standard user account, not a guest account. Elevated
privileges can be revoked even if the user is a local admin.

Privilege Manager for Windows 4.4 Administrator Guide
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Installing Privilege Manager
System requirements
Installing the Console
Configuring the Server
Installing the Client
Upgrading
Uninstalling

To complete the Privilege Manager installation, you need to install the Console, configure the Server, and install
the Client. Then you can start using Privilege Manager based on your Windows rights within the Group Policy
Management Console. If you do not have enough rights on an object, you are prompted that access is denied.

System requirements
Please refer to the Privilege Manager for Windows Quick Start Guide for the list of System Requirements.

Installing the Console
The Console must be installed on a computer that is joined to the domain and run under a user account that has
the rights to change at least one GPO. The Console displays GPOs based on the security context of the user that
is logged on.

Using the Console Windows Installer file
Please refer to the Privilege Manager for Windows Quick Start Guide for instructions on using the Console
Windows Installer file.

Privilege Manager for Windows 4.4 Administrator Guide
Installing Privilege Manager
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Opening the Console
To start the Privilege Manager Console on the host:

1. Go to Start > All Programs > Quest > Privilege Manager > Privilege Manager, or

2. Select the Privilege Manager shortcut icon on the Start menu.

Applying a license
You can apply a license upon initial start-up or later. Otherwise, if your trial has expired, you’ll only be able to
access the Community edition.

To apply a license when you start the Console for the first time:

1. A window appears, asking you to apply a license.

2. Click Yes if you are going to apply a Privilege Manager Professional or Professional Evaluation license.
Browse to the license file and click Open.
Or,

3. Click No to access the Privilege Manager Community Edition that does not require a license.

To apply a license in the Console after initial start-up:

1. Click Help > About in the menu.

2. Click the Licenses tab.

3. Click the Apply License File button.

4. Highlight the product name and click the Update License button.

5. Browse to the license file and click Open and then OK.

6. If you are upgrading, you may need to follow the additional steps detailed in the Upgrading section.

Viewing GPOs
To view the GPOs that you have access to:

1. Switch from the Setup Tasks > Getting Started window to the Group Policy Settings > All
GPOs window.
The GPOs you have access to appear.

NOTE: If you do not see the domain tree when the Group Policy Settings section is selected,
check that the default domain is selected in the Setup Tasks > Select Target Domains window.

Selecting target domains
The Privilege Manager Console is initially configured to allow you to manage the privilege Elevation settings for
the domain to which the local computer belongs. In addition, the Console also allows you to manage other

Privilege Manager for Windows 4.4 Administrator Guide
Installing Privilege Manager
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domains in your forest.
For Windows Privilege Manager to work across multiple domains within a single forest, the appropriate domain
permissions must be configured and an Enterprise Admin Active Directory account must be used with the
Privilege Manager Console. The Windows user account must be include the following:

l SQL Server System Administrators role

l db_owner access to the master database

l db_owner access to the PAReporting database (required for upgrades)

For complete information about the database space requirements, see Database Planning.

NOTE: The recommendation for multiple domains in a single forest is for each domain within the forest to
host a completely separate installation of Privilege Manager.

To customize the number of your forest’s domains available in the Group Policy Settings pane:

1. In the Getting Started section of the navigation pane, select Setup Tasks and then click Select
Target Domains in the right pane.

2. In the window that appears, specify the domain names, as applicable.

3. (Optional) Click the Select DC button to open the Select Domain Controller dialog box. Specify the
exact domain controller that the Console will communicate with.
The list of the domains and GPOs change accordingly.
NOTE: You can create the GPO rules only on a domain where you have write permissions for the GPOs.

Installing a second Console
You may need to use this scenario if you need to manage Privilege Manager GPOs from an MS Windows 10
client that is not the same server as the Privilege Manager Console/Server.
NOTE: There is no GPO locking mechanism so ensure that the same GPO is not edited at the same time from
different consoles. Changes can be lost when multiple saves occur.
To install a second Console, you must meet the following requirements:

l Use same license as for the first Console.

l Use same version of PM Console as the first Console.

l Permissions: User running the remote Console must be a member of the super user group
specified during the setup of the first Privilege Manager Console/Server. User must also have
permissions to edit GPOs.

To install a second Console:

1. Install the second Console on another machine.

2. Apply the same license that is used on the first Console.

3. Open the Console and go to Setup Tasks > Configure a server.

4. Click Browse to choose an existing Privilege Manager Server. In the box at the bottom, type the name of
the Server.

Privilege Manager for Windows 4.4 Administrator Guide
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5. To close the dialog, click OK, and then click Test to ensure a successful connection.

6. Click OK to finish.

7. Optional.If using Temporary Session Elevation passcodes:

a. On the original Privilege Manager Server, locate and copy this file: C:\Program Files
(x86)\Quest\Privilege Manager\Console\pmtse.ske.

b. On the second Console, locate the same file in same location.

c. Rename it to pmtse.ske.old.

d. Copy the pmtse.ske from the original Privilege Manager Server to the second Console.

e. Close and re-open the second Console.

Configuring the Server
Available only in Privilege Manager Professional and Professional Evaluation editions.

After installing the Console, a Server must be configured. Configuring the Server sets up the back-end services
needed to automatically deploy the Client, as well as enable reporting, discovery and remediation.

Using the Server Configuration Wizard
Please refer to the Privilege Manager for Windows Quick Start Guide for instructions on using the Server
Configuration Wizard.

Modifying the Server
You must configure the settings for the Server on the Console where it was installed. However, any
administrator with the rights to a specific GPO can update its data collection settings. Also, the administrator
running the Console can view reports of data collected by any Server by selecting Browse and the preferred
Server from the Privilege Manager Server Configuration screen (under Setup Tasks > Configure a Server).
If you need to change the reporting database settings, i.e., connect to another instance, modify the
authentication parameters, or set up a new data collection service:

1. Use the Privilege Manager Server Configuration screen to remove the Server.

2. Restart the wizard to reinstall the service and set the SQL database settings.

Removing the Server
If you do not want to use a Server, you can clear its settings and/or remove it from a
host computer:

1. Open the Privilege Manager Server Configuration screen (under Setup Tasks > Configure a Server).

2. Select Clear the server name to clear the settings which the Console uses to connect to reporting
information. The locally running Server will not be stopped or disabled. This will not uninstall the Server.

Privilege Manager for Windows 4.4 Administrator Guide
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3. Click Remove the Privilege Manager Server from this computer to uninstall the Server from the local
computer. When you remove the Server:

l You stop the web data collection service.

l The shared folder with the Client file is no longer shared.

l The database does not receive data sent by the corresponding Clients until a new Server is
installed, provided that it is installed within the network timeout parameters.

To remove a Server running remotely:

1. Connect to the computer that hosts the Server.

2. Remove the Server using the Privilege Manager Server Configuration screen.

NOTE: If a domain administrator or the administrator of a nested organizational unit (OU) uninstalls the
Server, they may render the reporting function unavailable on other Console computers or computers
downstream from the parent OU. Also, if you have reinstalled the Server, reports generate starting from
the last installation.

Installing the Client
Once the Console is installed, you can deploy Clients to the computers on your domain in one of
the following ways:

l Client Deployment Settings Wizard: Deploy or uninstall clients on your computers in one pass.
Available only in Privilege Manager Professional and Professional Evaluation editions.

l Client Windows Installer file: Use PAClient.msi to install the Client locally on a computer
(administrative privileges are required).

l Microsoft Group Policy Management Console: Use login scripts or other software deployment
techniques for mass-deployment.

Using the Client Deployment Settings Wizard
Please refer to the Privilege Manager for Windows Quick Start Guide for instructions on using the Client
Deployment Settings Wizard.

Using the Client Windows Installer file
To use the Client Windows Installer file to install the Client locally on a computer:

1. To locate the Client MSI setup file, open the Console.

2. Click Additional Resources > Open Client Installation Folder. The Client file appears in a
browser window.

Privilege Manager for Windows 4.4 Administrator Guide
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3. Check that the Client is successfully deployed onto the computer. Ensure that:

l The CSEHost.exe process is running.

l The Client record is shown in the Add/Remove Programs tool.

l The Privilege Manager icon and the right-click menu are available in the system tray on the
client computer.

New GPO rules created by Privilege Manager are applied to Client computers following a group
policy update.

Using the Group Policy Management
Console
To install Clients on your domain via the Microsoft Group Policy Management
Console (GPMC):

1. Copy the PAClient.msi file to a network share that can be read by all users. Or, just share the
file folder (a share with the PAClient.msi file is configured automatically upon Server
configuration).

a. To locate the Client MSI setup file, open the Console.

b. Click Additional Resources > Open Client Installation Folder. The Client file appears in
the browser window.

2. Right-click Group Policy Objects and select New from the pop-up menu to open the Group
Policy Management Console on the Server to create a new GPO.

3. Enter a name for the new GPO and click OK.

4. Right-click the new GPO and select Edit to open it.

5. In the Group Policy Management Editor, select Computer Configuration > (in Windows Server
2008) Policies > Software Settings > Software installation. In the right pane, right-click the new
GPO, and select New > Package.

a. If the client distribution GPO is computer-based (defined under Computer Configuration),
enable the Always wait for the network at computer startup and logon policy (located in
Computer Configuration > (in Windows Server 2008) Policies > Administrative
Templates > System > Logon). Otherwise, the Client installs after the second reboot of
the client computer.

b. If the client distribution GPO is user-based (defined under User Configuration), then the
Client installs after the first logon.

6. In the dialog box that appears, browse to the PAClient.msi file on the network share where it
was copied to.

a. Use the File name field to specify the Client location in the Universal Naming Convention
(UNC) format:

\\computername\sharename\filename.msi

b. Click Open.

7. Select Assigned in the Deploy Software dialog box.

Privilege Manager for Windows 4.4 Administrator Guide
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8. Assign the new GPO to a domain or OU.

a. To assign it to a domain, right-click the domain in GPMC and select Link an Existing GPO.

b. Select the GPO in the dialog box and click OK.

9. Check that the Client is successfully deployed onto the computer. Ensure that:

l The CSEHost.exe process is running.

l The Client record is shown in the Add/Remove Programs tool.

l The Privilege Manager icon and the right-click menu are available in the system tray on
the client computer.

New GPO rules created by Privilege Manager are applied to Client computers following a
group policy update.

Upgrading
Privilege Manager components are only compatible with other components of the same version.
Upgrading ensures that all of the GPO rules and reporting configurations you created with earlier
versions will still be available.

To upgrade prior versions:

1. Run the Privilege Manager setup file (PAConsole_Pro.msi) and follow the Privilege Manager Console
Windows Installer.

a. If a message displays, Some files that need to be updated are currently in use, click OK.

b. Once you complete the upgrade, exit the installer.

2. Open the Console and if necessary, apply a license. For more information, see Opening the Console on
page 10 and Applying a license on page 10.

3. If an error message notifies you that the ScriptLogic PA Reporting Service has the wrong, manual,
startup type, complete one of the following steps:

l Go to the Windows Services Console and set the ScriptLogic PA Reporting Service to start
automatically.

l Click OK in the message window to reset the service to start automatically. If the restart fails, click
NO, and then restart the Privilege Manager for Windows Console.

NOTE: The automatic Server upgrade may be unavailable if the ScriptLogic PA Reporting Service
is not running.

4. If the Console detects that the Server component is installed on a remote computer, it instruct you to
launch it on the remote computer.

Privilege Manager for Windows 4.4 Administrator Guide
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5. If a message prompts you to upgrade your Server and database (installed locally with the reporting
functionality of some prior Privilege Manager versions):

a. Click OK and follow the Privilege Manager Server Configuration Wizard to complete the
following steps:

i. Install missing SQL Server components from the Internet.

ii. Back up your database.

iii. Configure a shared folder for client mass deployment.

b. Click Finish to save the results and exit the wizard.

c. If a message displays indicating that the Privilege Manager Host Service that needs to be
updated is currently in use, click OK to ignore the message.

d. To upgrade later, open the Privilege Manager Server Configuration Wizard and confirm that
you are running the upgrade process before you configure the Server.

e. Until you have upgraded the Server and database, you will have problems installing the
Server locally.

f. For more information, see Configuring the Server on page 12.

6. Re-configure your Client data collection settings, if necessary.

a. Select a GPO from the Group Policy Settings section.

b. Switch to the Advanced Policy Settings tab.

c. Double-click Client Data Collection Settings to configure settings using the Client Data
Collection Settings Wizard. For more information, see Configuring Client data collection
on page 17.

7. After you upgrade, By Digital Certificate rules will be saved as By Path to the Executable rules.

8. To upgrade Clients, install the newer version over the older one. For more information, see Installing the
Client on page 13.

Uninstalling
You must have administrative privileges to uninstall the Console and Client from a local computer.

To uninstall Privilege Manager components:

1. Use the Windows Control Panel tool. The uninstaller completely removes all of the data.

2. Once Privilege Manager for Windows is removed, its rules no longer apply.

For more information, see Removing the Server on page 12.

Privilege Manager for Windows 4.4 Administrator Guide
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Configuring Client data collection
Using the Client Data Collection Settings Wizard

Available only in Privilege Manager Professional and Professional Evaluation editions.

Run the Client Data Collection Settings Wizard so that you can compile reports, support discovery, and launch
on-demand features.

Using the Client Data Collection
Settings Wizard
Client data collection settings only apply on computers running a Client.
Before configuring Client data collection settings, you must configure a Server on your domain. For more
information, see Configuring the Server on page 12.

To use the Client Data Collection Settings Wizard to set up, modify, or discard settings:

1. Open the wizard by completing one of the following steps:

l Open the Client Data Collection Settings Wizard from the Setup Tasks section. It will always
show the default settings.

l On the Advanced Policy Settings tab of the target GPO, double-click Client Data Collection
Settings. The changes made within the wizard are saved here.

2. Enable the Client Data Collection Settings on the State tab.

l Choose Enabled, to ensure the settings apply to the selected GPO.

l Choose Not Configured, to enable child GPOs to inherit settings from their parent.

3. Define the Server on the Settings tab. This Server receives data from the Clients of the target GPO.

a. Click the Browse button to locate a Server through Active Directory.

b. Use the Test button to verify the selected Server's connection to the ScriptLogic PA Reporting
Service. If the test fails, check to see if there are network or firewall problems.

Privilege Manager for Windows 4.4 Administrator Guide
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c. Click the Clear the server name link if you want to configure another Server. The displayed
service remains installed.

NOTE: To prevent data transfer issues between the Server and linked Clients, check that the port
you have selected is open for incoming connections on the Server. Port 8003 is the default port for
Server installation.

4. Use the Advanced Settings on the Settings tab to set these data transfer parameters:

l Maximum Sleep Time (in seconds) sets the stagger time period within which every Client sends its data
to the data collection service. This value is set to 60 seconds by default.

l Send Retries defines the number of retries that are made if an attempt to connect to the web service
fails. This number is set to 1 by default.

l Network Timeout (in seconds) sets how many seconds a Client should wait to stop sending data if it
does not reach the target. This value is set to 600 seconds by default.

l Maximum Records Per Transaction indicates how many portions of cached data the Client sends. This
value is set to 0 by default, which indicates an unlimited number. To reduce the load on the Server side,
you can increase the value to 1 or 2. This may be useful on large networks where each client computer
generates many records and a Client may not be able to connect to the data collection service because
it is too busy processing data collection transactions.

5. Click Next to use Validation Logic to target the settings to specific client computers or user accounts
within the GPO, or click Finish to save your settings and quit.
If an error message indicates that the target GPO is not selected:

a. Click OK to close the message window.

b. Open the GPO tab and select the desired GPO.

6. Click Save on the GPO toolbar to save the new settings.

Adjust the parameters that Clients use to send their data to the ScriptLogic PA Reporting data collection web
service to your specific needs. The web service supports collecting data from a significant number of Clients
running concurrently.

Privilege Manager for Windows 4.4 Administrator Guide
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Configuring Instant Elevation
Using the Instant Elevation Wizard

Available only in Privilege Manager Professional and Professional Evaluation editions.

To grant on-demand administrative privileges to a group of trusted users and audit their actions, use the Instant
ElevationWizard.

NOTE: In some cases, Instant Elevation and Blacklisting rules could be configured for the same
target application. In this case, Blacklisting takes precedence over Instant Elevation and prevents
the application from starting. For more information about creating Blacklisting rules, see Using the
Create Rule Wizard.

Using the Instant Elevation Wizard
Before you configure Instant Elevation settings, ensure the following components are set up:

1. The Client is running on the computers you want to apply the settings to;

2. The Server is configured and running with the port that you have selected allowed for incoming data (the
default port is 8003); and

3. Client data collection settings are enabled for the selected GPO.

To use the Instant Elevation Wizard to set up, modify, or discard privileges:

1. Open the wizard by completing one of the following steps:

l Open the Instant Elevation Wizard from the Setup Tasks section. It will always show the
default settings.

l Double-click Instant Elevation Settings on the Advanced Policy Settings tab of the target GPO.
The changes made within the wizard are saved here.

2. Enable the Instant Elevation Settings on the State tab.

l Choose Enabled, to ensure the settings apply to the selected GPO.

l Choose Not Configured, to enable child GPOs to inherit settings from their parent.
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3. Use the Groups tab to alter the settings. By default, users of the target GPO automatically inherit the
administrator's settings (BUILTIN\Administrators).

4. Complete the advanced options in the Privileges and Integrity tabs.

5. Click Next to use Validation Logic to target the settings to specific client computers or user accounts
within the GPO, or click Finish to save your settings and quit.
If an error message indicates that the target GPO is not selected:

a. Click OK to close the message window.

b. Open the GPO tab and select the desired GPO.

6. Click Save on the GPO toolbar to save the new settings.

7. Users can click the Elevate! button to launch privileged applications without interruptions. The button
is available on the context menu of Windows Explorer objects that require elevated privileges to start up,
including: .bat, .cmd, .exe, .js, .lnk, .msc, .msi, .msp, .pl, .ps1 or .vbs (.lnk is for
shortcuts).

8. Run an Instant Elevation Report to view the processes that are launched. For more information, see
Instant Elevation Report on page 59.
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Configuring Self-Service Elevation
Using the Self-Service Elevation Request Settings Wizard
Selecting how users access the request form
Customizing Self-Service request email messages
Using Self-Service Notifications
Using the Self-Service Elevation Request Processing Wizard
Using the Console Email Configuration screen

Available only in Privilege Manager Professional and Professional Evaluation editions.

To enable users to request permissions to use privileged applications, use the Self-Service Elevation Request
Settings Wizard. Whenever a user attempts to run an application which requires administrative permissions for
which they do not have rights, they are asked if they would like to send a request to their administrator for
permission to run it.
You can select how users access the request form and set up Self-Service notifications to email you, the help
desk, and your manager of each request. Then, you can process the request within the Self-Service
Elevation Requests section of the Console and email your decision to the user, using the Console Email
Configuration screen.

NOTE: In some cases, Self-Service Elevation and Blacklist rules could be configured for the same
target application. In this case, Blacklisting takes precedence over Instant Elevation and prevents
the application from starting. For more information about creating Blacklisting rules, see Using the
Create Rule Wizard.

Using the Self-Service Elevation
Request Settings Wizard
Before you configure Self-Service Elevation request settings, ensure the following components
are set up:

1. The Client is running on the computers you want to apply the settings to;

2. The Server is configured and running with the port that you have selected allowed for incoming data (the
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default port is 8003); and

3. Client data collection settings are enabled for the selected GPO.

To use the Self-Service Elevation Request Settings Wizard to set up, modify, or discard
privileges:

1. Open the wizard by completing one of the following steps:

l Open the Self-Service Elevation Request Settings Wizard from the Setup Tasks section. This
section always show the default settings.

l On the Advanced Policy Settings tab of the target GPO, double-click Self-Service Elevation
Request Settings . The changes made within the wizard are saved here.

2. Enable the Self-Service Elevation Request Settings on the State tab.

l Choose Enabled, to ensure the settings apply to the selected GPO.

l Choose Not Configured, to enable child GPOs to inherit settings from their parent.

3. Use the Settings tab for Selecting how users access the request form.

4. Click Next to use Validation Logic to target the settings to specific client computers or user accounts
within the GPO, or click Finish to save your settings and quit.
If an error message indicates that the target GPO is not selected:

a. Click OK to close the message window.

b. Open the GPO tab and select the desired GPO.

5. Click Next to use the Filters tab to filter out Self-Service Request data according to different application
specific criteria.
On the Filters tab, select the check box to enable application filters.
Enter filter criteria in one or more of the available boxes (Executable path contains, Product name
contains, Publisher name contains, and File description contains).

NOTE: The Publisher name contains field looks at the Publisher or Company Name attribute.

An application only needs to meet a single filter criteria in order for its Self-Service Request data to be
filtered out. A comma delimiter can be used to enter multiple criteria in each filter box.

NOTE: The Privilege Manager Client does not transmit any Self-Service Request data for any
application that meets at least one of the existing filter criteria.

6. Click Save on the GPO toolbar to save the new settings.

Selecting how users access the
request form
Use the Settings tab of the Self-Service Elevation Request Settings Wizard to select how end users access
the request form and set up email confirmation and notification settings. You can combine the following options:
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OPTION ACTION

Automatically ask users if they
would like to request that a privilege
elevation rule be created whenever
they attempt to launch applications
which require privilege elevation to
run
This option is enabled by default.

Once a user closes the User Account Control (UAC) window, a Self-
Service Elevation Request Prompt will display.

NOTE: Not all applications which display UAC windows will
automatically pop up a Self-Service Elevation Request Form.
You can allow the user to manually submit Self-Service
requests by enabling the Add a Windows explorer shell
option described below. Windows Installer files (.msi)do not
automatically trigger Self-Service Prompts, so the Self-
Service Elevation Request Form must be manually triggered
by users.

Allow users to hide or disable these
prompts
This option is enabled by default.

l Users can select whether the request form displays in the
future by checking the In the future, don't showme this
when I try to run applications that need approval check
box.

l A user on a client computer can re-enable/disable the prompt
using the Display Self-Service Prompts icon on the context
menu of the system tray.

NOTE: This setting does not affect the Self-Service Elevation
Request Form launched with the Elevate! button. It only
affects the request forms displayed automatically.

Add a Windows explorer shell
extension allowing the user to right-
click on a program or shortcut in
order to request that a privilege
elevation rule be created for that
program
This option is enabled by default.

l Users can click the Elevate! button to launch privileged
applications without interruptions. The button is available on
the context menu of Windows Explorer objects that require
elevated privileges to start up, including: .bat, .cmd,
.exe, .js, .lnk, .msc, .msi, .msp, .pl, .ps1 or
.vbs (.lnk is for shortcuts).

l Users can click the Elevate! button to launch the Self-
Service Elevation Request Form or Instant Elevation, if it is
enabled.

Allow user to specify the email
address where a confirmation email
should be sent once the
administrator has processed the
request for the privilege elevation
rule.
(If this option is not checked, the
email will be sent to the user's
Exchange account as found in
Active Directory.)
This option is disabled by default.

The user can enter an email address into the corresponding text
field.
By default, the field is pre-populated with the email address of the
user who is logged in (provided that it is specified in Active
Directory).

Send an email notification to the Enter the Email Address for the administrator and/or the help desk
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OPTION ACTION

administrator whenever a user
submits a Self-Service Elevation
Request
This option is disabled by default.

or other recipients. Use the + button to add entries and the x button
to remove them.
By default, the Email Subject is pre-populated with Privilege
Manager Self-Service Elevation Request as the subject line. You
can enter your own subject and press the Reset button to reset it to
the default.

Customizing Self-Service request
email messages
The approval and denial email messages that are sent as a response to the user's Self-Service Elevation
request can be customized.

The default Approval message says the following:

MESSAGE_NAME:ApprovedRequest

MESSAGE:

Your request to run the following application with elevated privileges has been
"approved".

Request Date: <ExecutionDate>

Requested Application:

<ProductName>

<Path>

<Arguments>

Reason for request: <Reason>

This new privilege should be available on your computer once Windows has refreshed its
domain security policies.

The default Denial message says the following:

MESSAGE_NAME:NotApprovedRequest

MESSAGE:

Your request to run the following application with elevated privileges has "not"
been approved.

<ProductName>

<Path>

Please contact your administrator for more details.
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These messages can be customized by opening the MessageTemplates.cfg file in the Privilege
\Console folder.

Each message in the CFG file starts with ======StartOfMessage========= and ends with
======EndOfMessage============.
The text between these delimiters can be customized to your liking.
Text delimited with angle brackets "< >" are variables that are replaced with data at runtime.
The following variables may be used in the Approval message:

l ExecutionDate

l ProductName

l Path

l Arguments

l Reason

The following variables may be used in the Denial message:

l ProductName

l Path

Using Self-Service Notifications
If you would like to receive an email when a user on a client computer submits a Self-Service Elevation
Request Form, you can set up a Self-Service Notification. You can configure it to go to multiple recipients,
including you, your manager, and/or the help desk. In addition, you can set the subject line to meet the
requirements of your help desk.

To set up Self-Service Notifications:

1. Configure the Server.

a. Use the Privilege Manager Server SetupWizard to configure the Server Email Notification
Configuration settings on the first screen of the wizard.

b. If you previously completed the wizard, the remaining screens are automatically populated.

c. Refer to the Privilege Manager for Windows Quick Start Guide for step-by-step instructions.

2. Configure the recipient.

a. Use the Settings tab on the Self-Service Elevation Request Settings Wizard to configure the
Email Notification Settings.

b. For more information on the wizard, see Using the Self-Service Elevation Request Settings
Wizard on page 21.

c. For more information on setting up Email Notification Settings, see Send an email notification to
the administrator whenever a user submits a Self-Service Elevation Request

3. Check your email for the Self-Service Notification, containing information on the user, the request, and
the client’s computer.
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4. Accept or reject the user's request Using the Self-Service Elevation Request Processing Wizard.

5. Inform the end user of your decision Using the Console Email Configuration screen.

Using the Self-Service Elevation
Request Processing Wizard
Shortly after a user on a client computer has submitted a Self-Service Elevation Request Form, you can view
and/or process it within the Self-Service Elevation Requests section of the Console (provided that your
environment is properly configured according to the Maximum Sleep Time setting).
You can only view data stored in the database of the server that is selected in the Server configuration (under
Setup Tasks > Configure a Server).
When processing a Self-Service Elevation request, you can either create a rule to elevate privileges for the
process or deny the request. You can then email your decision to the user using the Console Email
Configuration screen.

To view or process Self-Service Elevation requests:

1. Open the Self-Service Elevation Requests section from the navigation pane of the Console. The
requests apper in the window on the right.

2. Click the Display requests button to list the Self-Service Elevation requests submitted by users, based
on the default filter settings shown in the Applied Filters section at the top of the screen.

3. Select a request in the Self-Service Elevation Requests grid below. Use the grid's column headers to
sort the requests.

By default, the following information appears:

a. Requests to elevate any type of applications;

b. Requests sent during the last 30 days; and

c. Requests that have never been processed with the Process request button from the
current section.

4. Use the Applied Filters wizard to modify the list. You can create multiple shared filter sets and
save settings that other administrators can use. For more information, see Using the Applied Filters
Wizard on page 62.

5. Select a record and then click Process request to open the Self-Service Elevation Request
ProcessingWizard.

6. On the first tab of the wizard, view the details for a process that failed to start, and the reason for
requesting Elevation privileges. Click Next.
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7. Indicate whether you want to create a rule to elevate the privileges for this process, or deny the request.

a. If you approve the request, the Create Rule wizard appears, allowing you to create a rule for the
requested process. By default, the rule is created for a specific user at a specific computer, and
the Administrators group (stored within the BUILTIN\Administrators Active Directory OU) is
added to the rule. Use the Validation Logic tab to modify this setting.

b. When a request is processed and a rule is created for it (or it has been denied), the Processed
Action column displays a rule created or ignored value.

c. To view ignored requests or requests for which the rules were created, change the Process Date
of Item filter on the Applied Filters Wizard from None: Item has not been processed to the
corresponding Date Range.

8. Select whether or not to email your decision to the user. This feature requires that you set up the
Console Email Configuration settings.

9. Click Finish to save.
The rule created from the request is added to the selected GPO with a default name.

10. Select Export to export the list of requests presented on the grid. The list will be saved as an .xls file.

After the rule has been created:

l The rule is added to the target GPO of the Group Policy Settings section.

l The rule applies after the GPO settings are updated on the client computer.

Using the Console Email
Configuration screen
If you want Privilege Manager to send an email message to the user after approving or denying their Self-
Service Elevation request, you can configure the settings using the Console Email Configuration screen found
under Setup Tasks.

To configure the Server to send your Self-Service Elevation request approval or refusal:

1. Select Console Email Configuration from the Setup Tasks section.

2. Configure the following fields:

a. Host Name: Enter the SMTP Server name of the email account from which you are going to send
your emails.

b. SMTP Port: Enter the port number.

c. SMTP User Name and Password: If necessary, enter the authentication information and check
the SSL check box.

d. From Email: Enter the corresponding email.
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3. Click Send Test Email to send an email to the account specified in the From Email field.

a. If Privilege Manager succeeds in sending the email, the corresponding message appears.

b. Log into an email program with the corresponding account and locate the sent email folder, with
Privilege Manager Test Email in the subject.

4. Click OK to save the settings and quit.
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Configuring Temporary Session
Elevation

Using the Temporary Session Elevation Passcode Manager
Available only in Privilege Manager Professional and Professional Evaluation editions.

Temporary Session Elevation (TSE) allows an administrator to generate Elevation passcodes that can provide
end users the ability to temporarily elevate the privileges of any process or application on their machine. The
passcodes work for both on-network and off-network machines, even if there are active internet connections.
Temporary Session Elevation passcodes are intended to be used during a specific user session. A user session
comprises the period between the user logon and logoff times, regardless of the reason that caused the logoff.
Temporary Session Elevation passcode usage can be limited by time or number of uses. More granular
limitations can selected by using Validation Logic in the passcode. Examples of this are limiting use by
computer name, user name or time and date range. When the passcode is used on a client computer, Validation
Logic allows or denies usage based on selected options.

NOTE: In some cases, Temporary Session Elevation and Blacklisting rules are configured for the
same target application. In this case, Blacklisting takes precedence over Temporary Session
Elevation and prevents the application from starting. For more information about creating
Blacklisting rules, see Using the Create Rule Wizard.

For more information, see the following KB articles:

l Temporary Session Elevation: Duration (293630)

l Temporary Session Elevation: What is a session? (293610)

Using the Temporary Session
Elevation Passcode Manager
Before you configure Temporary Session Elevation settings, ensure the following components
are set up:

1. The Client is running on the computers you want to apply the settings to.

2. The Server is configured and running with the port that you have selected allowed for incoming data (the
default port is 8003).

3. Client data collection settings are enabled for the selected GPO.

4. The cCient is enabled to use offline passcodes to create Temporary Elevated Sessions (enabled in the
Client Deployment Settings wizard).

To use the Temporary Session Elevation Wizard to set up privileges:

1. Open the wizard:

a. Open Passcode Manager from the Temporary Session Elevation section on the navigation
pane of the Console.
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2. Create a new passcode:

a. Click New to start the Instant Elevation TSE passcode generator.

3. Enable the Instant On Demand Privilege Elevation settings on the State tab.

l Choose Enabled, to ensure the settings apply to the selected GPO.

l Choose Not Configured, to enable child GPOs to inherit settings from their parent.

4. Use the Groups tab to alter the settings. By default, users of the target GPO will automatically inherit the
administrator's settings (BUILTIN\Administrators).

5. Complete the advanced options in the Privileges, Integrity and Validation Logic tabs.

6. The Passcode is created on the next tab, Passcode.

a. Enter a Title to describe the passcode.

b. Enter a Maximum allowed usage. This is the number of times the passcode can be used
before expiring.

c. Enter a Duration. The duration is the amount of time the passcode remains active, after
being activated.

d. Optionally, select the check box to End all elevated processes (and child processes) when
Passcode duration expires. If selected, all windows that are opened with a Temporary Session
Elevation passcode are closed.

e. Click Export to file to save the passcode for end-user use.

7. Click Finish to complete the wizard.

a. The passcode is delivered to the user for usage.

8. Run a Temporary Session Elevation Usage Report to view the processes that have been launched. For
more information, see Temporary Session Elevation Request Report on page 59.

Privilege Manager for Windows 4.4 Administrator Guide
Configuring Temporary Session Elevation

30



7

Configuring privileged application
discovery

Using the Privileged Application Discovery Settings Wizard
Processing discovered privileged applications

Available only in Privilege Manager Professional and Professional Evaluation editions.

Use the Privileged Application Discovery Settings Wizard to collect information about the privileged
applications used over your network during a specified time period. By default, once this feature is enabled, it is
set to collect information for two weeks, but you can adjust the setting.

Using the Privileged Application
Discovery Settings Wizard
Before you configure privileged application discovery settings, ensure the following components
are set up:

1. The Client is running on the computers you want to apply the settings to;

2. The Server is configured and running with the port that you have selected allowed for incoming data (the
default port is 8003); and

3. Client data collection settings are enabled for the selected GPO.

To use the Privileged Application Discovery Settings Wizard to set up, modify, or
discard settings:

1. Open the wizard by completing one of the following steps:

l Open the Privileged Application Discovery Settings Wizard from the Setup Tasks section. It
always shows the default settings.

l On the Advanced Policy Settings tab of the target GPO, double-click Privileged Application
Discovery Settings. The changes made within the wizard are saved here.
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2. Enable the Privileged Application Discovery Settings on the State tab.

l Choose Enabled, to ensure the settings apply to the selected GPO.

l Choose Not Configured, to enable child GPOs to inherit settings from their parent.

3. Use the Settings tab to set the period during which the settings apply and the data is collected (a month
by default).

4. Click Next to use Validation Logic to target the settings to specific client computers or user accounts
within the GPO, or click Finish to save your settings and quit.
If an error message indicates that the target GPO is not selected:

a. Click OK to close the message window.

b. Open the GPO tab and select the desired GPO.

5. Click Next to use the Filters tab to filter out Application Discovery data according to different application
specific criteria.
On the Filters tab, select the check box to enable application filters.
Enter filter criteria in one or more of the available boxes (Executable path contains, Product name
contains, Publisher name contains, and File description contains).
An application only needs to meet a single filter criteria in order for its Application Discovery data to be
filtered out. A comma delimiter can be used to enter multiple criteria in each filter box.

NOTE: The Privilege Manager Client does not transmit any Application Discovery data for one or
more applications that meet any of the existing filter criteria.

6. Click Save on the GPO toolbar to save the new settings.

Processing discovered privileged
applications
Once a privileged process starts (or failed to start) on a client computer, the corresponding information is sent to
the Server and displayed in the Privileged Application Discovery section of the Console (provided that your
environment is properly configured according to the Maximum Sleep Time setting).
You can only view data stored in the database of the server that is selected in the Server configuration (under
Setup Tasks > Configure a Server).
When processing a discovered privileged application, you can either create a rule for it so that a user without
elevated privileges can launch it, or choose to mark it as processed so that it will not display in the list (unless
the filter is specifically set to display it).
Use the Generate Rules wizard to automatically create a number of rules for different types of applications in
one pass. Rules are created based on the preferences with which the application was started. You can select
an application and view its preferences in the Privileged Applications Discovered grid.
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Using the Generate Rules Wizard
To view discovered privileged applications and generate rules for them:

1. Open the Privileged Application Discovery section from the navigation pane of the Console. The
applications are displayed in the window on the right.

2. Click the Display applications button to list the privileged applications and other processes that are
started (or failed to start), based on the default filter settings shown in the Applied Filters section on the
top of the screen.

3. Select an application in the Privileged Applications Discovery grid below. Use the grid's column
headers to sort the applications.

By default, the following information appears:

l Any type of privileged applications

l Privileged applications that were discovered during the last 30 days

l Privileged applications that have no generated rule in the current section, or are marked
as ignored

4. Use the Applied Filters wizard to modify the list. You can create multiple shared filter sets and
save settings that other administrators can use. For more information, see Using the Applied Filters
Wizard on page 62.

5. Select a record and then click the Generate rules button to open the Generate Rules Wizard wizard.

a. On the first tab of the wizard, specify your rule type preferences. Click Next.

b. Add Validation Logic preferences into the rule, if necessary. The selected preferences will be
used to create the corresponding Validation Logic type. Click Next.

c. Review your rules and click Next, or

a. Click the Review rules that will be created button to open a window with more
information.

b. Click the Details button for more information, or click Close.

d. Select a target GPO for the rule and specify the GPO policy type. By default, the Administrators
group (stored in the BUILTIN\Administrators Active Directory OU) is added to the rule. Click
Create to save the rule.

6. Once a discovered privileged application is processed and a rule is created for it, or it has been marked
as ignored, the application is considered processed.

7. To view ignored applications or applications for which the rules are created, change the Process Date
of Item filter on the Applied Filters Wizard from None: Item has not been processed to the
corresponding Date Range.

8. The rule created from the application is added to the selected GPO with a default name.

9. Select Export to export the list of applications presented on the grid. The list is saved as an .xls file.

After the rule has been created:

l The rule is added to the target GPO of the Group Policy Settings section.

l The rule applies after the GPO settings are updated on the client computer.
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Deploying rules
Using the Create GPO with Default Rules Wizard (Privilege Elevation Rules only)
Using the Group Policy Management Editor
Using the Create Rule Wizard
Managing rules
Testing rules

Privilege Manager for Windows can create Privilege Elevation Rules and Blacklisting Rules. Privilege Elevation
rules are rules that raise the permissions level of the user for an application. Blacklisting rules deny a user
access to an application, regardless of what their default domain user permissions allows.

You can create five types of rules with Privilege Manager for Windows:

l By Path to the Executable: a file rule that applies to the path to an executable. For more information,
see Creating file rules on page 40.

l By Folder Path: a folder path rule that applies to all processes run from a path. For more information,
see Creating folder path rules on page 42.

l By ActiveX Rule: an ActiveX rule that applies to a specific URL. For more information, see Creating
ActiveX rules on page 43.

Available only in Privilege Manager Professional and Professional Evaluation editions:

l By Path to Windows Installer: a rule that applies to the path to Windows Installer files and patches.
For more information, see Creating rules for Windows Installer files on page 45.

l By Path to Script File: a rule that applies to the path to a script file. For more information, see
Creating rules for script files on page 46.

You can create a rule in one of the following ways:

l Create a default rule using the Create GPOwith Default Rules Wizard.

l Create a new rule using the Group Policy Management Editor or the Create Rule Wizard.
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Once you create a rule, you can:

l Test the rule. For more information, see Testing rules on page 52.

l Edit or delete the rule. For more information, see Managing rules on page 51.

l Build a report to view the rule's settings, save them into a file, and get statistics on the rule’s usage. For
more information, see Reporting on page 56.

Using the Create GPO with Default
Rules Wizard (Privilege Elevation
Rules only)
Privilege Manager for Windows contains a range of useful default rules that you can add to a new or existing
GPO. To create the default rules provided by Privilege Manager, use the Create GPOwith Default Rules
Wizard. To access the wizard from the Getting Started screen, select the Setup Tasks tab and then double-
click Create GPOwith default rules.

NOTE: Rules created with this process are Privilege Elevation rules only. Blacklist rules cannot be
created here.

To use the Create GPO with Default Rules Wizard:

1. Double-click Create GPOwith default rules to open the wizard.

2. Review the text in the Introduction dialog and click Next.

3. In the Select privilege elevation rules dialog, select your operating system from the drop-down menu
and select the corresponding rules from a list of common ones. Click Next.
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4. In the Select target GPO dialog, select or create a GPO to assign the rule to complete one of the
following steps:

l Select a GPO from the list under the domain that your local computer is a part of.

l Select a domain, click the Create GPO button, name it, and click OK. The newly created GPO is
added to the All GPOs list in the Group Policy Objects container.

l Link any GPO not marked with the icon to your domain or Active Directory OU.

i. Highlight the GPO in the left pane and click the Link GPO button on the right to link the
GPO to the domain or an OU.

ii. Browse for an OU or add the GPO to the domain in the dialog box that appears.

iii. Click OK.

iv. Once the rule is created, its icon changes to to indicate that it contains a rule and it is
listed in the GPOs with Policy Settings node.

NOTE: You can only link a GPO to an item for which you have sufficient rights. For more
information, see Select user policy or computer policy.

l Click Finish to save and apply the rule. If you did not specified the required data, the wizard
notifies you.

5. An error message will notify you if you have insufficient permissions to perform any of the operations
listed above.

l You must have permission to perform the same actions in the GPMC.

l Contact your system administrator to get the proper permissions.

6. The displays in the list of rules for the corresponding GPO under the Group Policy Settings section.

7. The rule is applied once the Group Policy is updated on the client computer.

8. A message notifies you that the rule’s parameters change when the trial period expires, if you create a
rule with any of the Privilege Manager Professional features while using the evaluation edition. For more
information, see Editions on page 7.

9. Modify the rule, as necessary. For more information, see Managing rules on page 51.

Using the Group Policy Management
Editor
The Group Policy Management Console (GPMC) is a built-in Microsoft Management Console (MMC) snap in.

You can use the features in Privilege Manager based on your Windows rights within the GPMC.

You can use the Group Policy Management Editor in the GPMC to manage and create rules or you can use the
Create Rule Wizard in the Privilege Manager for Windows Console.
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To use the Group Policy Management Editor to create and manage rules:

1. Open the MMC. On the Start menu, click Run, type MMC, and then click OK.

2. From the File menu, select Add/Remove Snap-in. The Add or Remove Snap-ins dialog box appears.

a. SelectGroup Policy Management under the list of snap-ins.

b. Click the Add button.

c. Click OK.

3. The Console Root window now has a snap-in, Group Policy Management, rooted at the Console
Root folder.

4. Right-click a GPO under your forest in the Group Policy Management pane on the right and select Edit.
The Group Policy Management Editor will open. The editor now has Privilege Manager for Windows
nodes, under Computer Configuration and User Configuration.

l The right pane has an Extended and a Standard tab.

l Click the Extended tab for more information about an item.

5. Available only in Privilege Manager Professional and Professional Evaluation editions. To create new

rule, select a Privilege Manager for Windows node and use the New Rule button, or use the other

toolbar buttons to delete or modify it. Before clicking the New Rule button, ensure select the
Privilege Elevation Rules or Blacklist Rules tab is selected.

Using the Create Rule Wizard
To use the Create Rule Wizard:

1.1. Select or create a GPO in the All GPOs node in the left pane of the Privilege Manager for
Windows Console:

a. Select a GPO from the list under the domain that your local computer is a part of.

b. Select a domain, click the New GPO button, name it, and click OK. The newly created GPO is
added to the All GPOs list in the Group Policy Objects container..

2. Link any GPO not marked with the icon to your domain or Active Directory OU.

a. Highlight the GPO in the left pane and click the Link button above it.

b. Browse for an OU or add the GPO to the domain in the dialog box that appears.

c. Click OK.

d. Once the rule is created, its icon changes to to indicate that it contains a rule and it is listed in
the GPOs with Policy Settings node.

NOTE: You can only link a GPO to an item for which you have sufficient rights. For more
information, see Select user policy or computer policy.
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3. Use the Create Rule Wizard to configure the rule.

a. Select the Privilege Elevation Rules or Blacklist Rules tab based on the type of rule
to be created.

b. Click the New Rule button to open the Create Rule Wizard.

c. Specify the data requested in each tab and click Next.

i. Privilege Elevation rules only. Follow the prompts through the default tabs: Start,
Description, Type, Groups, and Validation Logic (available only for Privilege Manager
Professional). The Privileges and Integrity tabs display as advanced options.
Blacklist rules only. Follow the prompts through the default tabs: Start, Description, Type,
and Validation Logic (available only for Privilege Manager Professional).

ii. Enter the required fields, marked with an asterisk '*' on the Description and Type tabs.
Blacklist rules only. In some cases, Blacklist rules could be configured with Instant,
Temporary Session, or Self-Service Elevation, for the same target application. In this
case, Blacklisting takes precedence over any type of Elevation and prevents the
application from starting. For more information, see the following sections:

l Configuring Instant Elevation

l Configuring Temporary Session Elevation

l Configuring Self-Service Elevation

d. Click Finish to save and apply the rule. If you did not specified the required data, the wizard
notifies you.

4. Click the Save button on the menu bar of the Rule section. Or, if prompted, confirm that you want to
save the rule.

5. An error message will notify you if you have insufficient permissions to perform any of the operations
listed above.

l You must have permission to perform the same actions in the GPMC.

l Contact your system administrator to get the proper permissions.

6. The rule is applied once the Group Policy is updated on the client computer.

7. A message notifies you that the rule’s parameters change when the trial period expires, if you create a
rule with any of the Privilege Manager Professional features while using the evaluation edition. For more
information, see Editions on page 7.
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Getting started
To use the Start tab in the Create Rule Wizard:

1. Select Create your own rule to create your own settings, or

2. Create a rule with pre-defined settings:

a. Select the Select common rule from the list below option.

b. Use the Operating System menu to sort the rules according to the operating system
they apply to.

c. Click Next to modify the default settings, or click Finish to save the your settings for the target
GPO and quit.

To use the Description tab in the Create Rule Wizard:

1. Enter a title to identify the rule and an optional description.

a. Check the Advertise this rule in the system tray on client computers option to display the title
of the rule when using the View current rules option on the Client system tray.

The system tray also pop ups a desktop notification message any time there is a change to the set
of rules flagged as advertised.

b. Check the Disable data collection activity for this rule option to enable/disable data collection
for the individual rule.

b. Check the Disable the rule regardless of validation option to stop the rule from applying until
you clear the option.

2. Click Next.

To use the Type Tab in the Create Rule Wizard to specify the essential parameters of the
processes for the rule:

1. Select the type of rule that you would like to create.

l By Path to the Executable: a file rule that applies to the path to an executable. For more
information, see Creating file rules on page 40.

l By Folder Path: a folder path rule that applies to all processes run from a path. For more
information, see Creating folder path rules on page 42.

l By ActiveX Rule: an ActiveX rule that applies to a specific URL. For more information, see
Creating ActiveX rules on page 43.

Available only in Privilege Manager Professional and Professional Evaluation editions:

l By Path to Windows Installer: a rule that applies to the path to Windows Installer files and
patches. For more information, see Creating rules for Windows Installer files on page 45.

l By Path to Script File: a rule that applies to the path to a script file. For more information, see
Creating rules for script files on page 46.
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2. Specify the options that correspond to the type of rule you have selected.

3. Select user policy or computer policy.

Define whether the rule will be user or computer-based.

l User Policy: Select this option to apply the rule to the user logged into the computer. This option
corresponds to the User Configuration node of the Group Policy Management Editor and is the
default policy for all editions of Privilege Manager for Windows.

l Computer Policy: Select this option to apply the rule to a computer irrespective of the user
logged in. This option corresponds to the Computer Configuration node of the Group Policy
Management Editor. Available only in Privilege Manager Professional and Professional
Evaluation editions.

Creating file rules
Use the By Path to the Executable rule to elevate or decrease privileges for processes that start from an
executable file.

To create a By Path to the Executable file rule using the Create Rule Wizard:

1. Open the Create Rule Wizard. For more information, see Using the Create Rule Wizard on page 37.

2. Specify the Path to an executable file on the client computer or a network share in one of the
following ways:

l Type the path to the file, including its extension, in the following format:

\\ComputerName\SharedFolder\Filename.exe

DriveLetter:\Filename.exe

l Use the common % variable and the * and ? wildcards to identify the path, for example,
*\filename.exe.

l Use the Browse button to locate the path. Once you locate the process, a dialog will
prompt you to:

a. Retrieve a digital signature for the rule's Publisher field. Click Yes to add the available
digital signature. Click No to skip the prompt.

b. Create a file version for the file. Click Yes to add the setting. Click No to skip the prompt.

c. Create a unique cryptographic hash for the file to secure its identification. Click Yes to add
the setting. Click No if you are creating the rule for the file for which data is likely to be
updated in the future, or for any file with its name within the specified folder.

Note: When saving the rule, Privilege Manager for Windows converts the path into
environment variables.

3. Click the Processes button to simplify adding parameters into the rule. Available only in Privilege
Manager Professional and Professional Evaluation editions.
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a. Select whether you will create the rule from a process on a local or remote computer.

b. A list of processes running on the computer will open. Locate the process and view its details in
the fields to the right:

l Path: the path to the process's executable.

l Arguments: the arguments with which the process was started.

l Publisher: the digital certificate of a publisher.

l Version: the File Version property.

l Hash: a unique cryptographic hash.

l Integrity level: the security level with which the process runs in Windows 7 and higher.

l Privileges: the privileges granted to the process.

c. Click OK. The data for the processes will be saved to the rule and displayed on the
corresponding tabs of the wizard.

d. To troubleshoot a Failed to retrieve processes. Please refer to documentation for more info
error, check the following on the remote computer:

i. The computer is turned on and accessible from the network;

ii. The domain administrator credentials have been provided; and

iii. Windows Management Instrumentation (WMI), Distributed Component Object Model
(DCOM), File and Printer Sharing, and Remote Administration are allowed through
the firewall.
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4. Fill in these optional fields, as necessary:

l Arguments: Specify the common or user-defined arguments with which the executable will run.
For example, to build a rule that will allow a non-administrator to access the Date/Time tool in the
Control Panel from the task bar, enter this data:

i. Path: %SystemFolder%\rundll32.exe

ii. Arguments: /d c:\windows\system32\shell32.dll,Control_RunDLL
timedate.cpl

l Available only in Privilege Manager Professional and Professional Evaluation editions.

l Publisher: Limit Elevation to files signed with the digital certificate of a publisher. Enter

the exact name or use the Browse button to locate it.

l File Version: Limit Elevation to those whose File Version property match the
ones specified.

l File Hash: Click the Browse button to locate the file and create a unique cryptographic hash
that limits Elevation to files that match it. This ensures that the rule will not apply to dangerous
content that is similarly named and will help prevent security issues.

NOTE: The file hash will not apply to a file that you have modified during program
updates, so do not add it to the rule for a file which is likely to be updated, or for any file
with the same name in that location.

l Apply settings to child processes: Ensure that child processes triggered by the rule will not fail
due to lack of privileges. This check box is enabled by default.

l User’s context will be used to resolve system and resource access: Ensure that the Client
uses the target's user environment to resolve file and registry access. This might be required to
resolve drive mappings, and also if the rule specifies the publisher, version, or file hash for the
target process running from a network location.

5. Define whether the rule will be user or computer-based.

l User Policy: Select this option to apply the rule to the user logged into the computer. This option
corresponds to the User Configuration node of the Group Policy Management Editor and is the
default policy for all editions of Privilege Manager for Windows.

l Computer Policy: Select this option to apply the rule to a computer irrespective of the user
logged in. This option corresponds to the Computer Configuration node of the Group Policy
Management Editor. Available only in Privilege Manager Professional and Professional
Evaluation editions.

6. Complete the Privileges (see Granting/denying privileges (Privilege Elevation Rules only)) and Integrity
(see Differentiating security levels (Privilege Elevation Rules only)) tabs to modify the rule.

7. Click Finish to quit the wizard.

8. The rule will be named after the executable.

Creating folder path rules
Use the By Folder Path rule to elevate or decrease privileges for processes that start from a folder path.
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To create a By Folder Path rule using the Create Rule Wizard:

1. Open the Create Rule Wizard. For more information, see Using the Create Rule Wizard on page 37.

2. Specify the location of a Folder on the client computer or a network share in one of the following ways:

l Type the folder path in the following format:

\\ComputerName\SharedFolder

DriveLetter:\Folder

l Use the common % variable and the * and ? wildcards to identify the folder, for
example, *\Folder

l Use the Browse button to locate the folder.

Note: When saving the rule, Privilege Manager for Windows converts the path into
environment variables.

3. Fill in these optional fields, as necessary:

l Available only in Privilege Manager Professional and Professional Evaluation editions.
Publisher: Limit Elevation to files signed with the digital certificate of a publisher. Enter the exact

name or use the Browse button to locate it.

l Apply settings to sub folders: Apply the rule to processes started from any file under any sub
folders of the path.

l Apply settings to child processes: Ensure that child processes triggered by the rule will not fail
due to lack of privileges. This check box is enabled by default.

l User’s context will be used to resolve system and resource access: Ensure that the Client
uses the target's user environment to resolve file and registry access. This might be required to
resolve drive mappings, and also if the rule specifies the publisher, version, or file hash for the
target process running from a network location.

4. Define whether the rule will be user or computer-based.

l User Policy: Select this option to apply the rule to the user logged into the computer. This option
corresponds to the User Configuration node of the Group Policy Management Editor and is the
default policy for all editions of Privilege Manager for Windows.

l Computer Policy: Select this option to apply the rule to a computer irrespective of the user
logged in. This option corresponds to the Computer Configuration node of the Group Policy
Management Editor. Available only in Privilege Manager Professional and Professional
Evaluation editions.

5. Complete the Privileges (see Granting/denying privileges (Privilege Elevation Rules only)) and Integrity
(see Differentiating security levels (Privilege Elevation Rules only)) tabs to modify the rule.

6. Click Finish to quit the wizard.

7. The rule will be named after the folder path.

Creating ActiveX rules
Use the By ActiveX Rule to allow installation of ActiveX controls from the Internet.
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To create an ActiveX Rule using the Create Rule Wizard:

1. Open the Create Rule Wizard. For more information, see Using the Create Rule Wizard on page 37.

2. Specify the URL for the ActiveX control in the Source URL field, for example:
http://*.macromedia.com*

3. Available only in Privilege Manager Professional and Professional Evaluation editions.

a. Click the Installed ActiveX Controls button to view details of the ActiveX controls installed on the
local computer and create rules based on them.

b. Fill in these optional fields, as necessary.

l Control: Enter the name of the ActiveX control from the CodeBase attribute of
the web page.

l CLSID/MIME: Restrict loading a control unless the CLSID or MIME value on the web page
matches the one specified.

l ActiveX Version: Restrict Elevation to ActiveX controls with a matching version number
on the web page from which it will be downloaded.

4. Define whether the rule will be user or computer-based.

l User Policy: Select this option to apply the rule to the user logged into the computer. This option
corresponds to the User Configuration node of the Group Policy Management Editor and is the
default policy for all editions of Privilege Manager for Windows.

l Computer Policy: Select this option to apply the rule to a computer irrespective of the user
logged in. This option corresponds to the Computer Configuration node of the Group Policy
Management Editor. Available only in Privilege Manager Professional and Professional
Evaluation editions.

5. Click Finish to quit the wizard.

6. The rule will be named after the ActiveX control.

Applying ActiveX rules
In order for an ActiveX rule to take effect on clients, set up the following components:

1. Enable Quest's GPE ActiveX Installer add-on in the Internet Explorer browser.

2. Open the Internet Options menu.

a. Uncheck the Enable Protected Mode check box on the Security tab.

b. Check the Enable third-party browser extensions* check box on the Advanced tab.

3. Restart Internet Explorer.

To centrally enable third-party browser extensions by modifying a GPO:

1. Create a dedicated GPO or open the Group Policy Management Editor.

2. Go to Computer Configuration > Administrative Templates: Policy definitions (ADMX files) >
Windows Components > Internet Explorer > Internet Control Panel > Advanced Page, and double-
click on Allow third-party browser extensions in the list to the right and enable it.

3. Open the User Configuration node and perform the configurations described in step 2 above.
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Creating rules for Windows Installer files
Available only in Privilege Manager Professional and Professional Evaluation editions.

Use the By Path to Windows Installer rule to elevate or decrease privileges for processes that start from
Windows Installer files (.msi) and patches (.msp).

To create a By Path to Windows Installer rule using the Create Rule Wizard:

1. Open the Create Rule Wizard. For more information, see Using the Create Rule Wizard on page 37.

2. Fill in the following fields:

l Name: Set a path to an .msi or .msp file. Wildcards are supported and you can use the Browse
button to locate the path.

Optional:

l Publisher: Limit Elevation to files signed with the digital certificate of a publisher. Enter the exact

name or use the Browse button to locate it.

l Product Code: Limit Elevation to those whose ProductCode MSI property match the one

specified. Enter the exact name or use the Browse button to locate it.

l Product Version: Limit Elevation to those whose ProductVersion MSI property match the
one specified.

l File Hash: Click the Browse button to locate the file and create a unique cryptographic hash
that limits Elevation to files that match it. This ensures that the rule will not apply to dangerous
content that is similarly named and will help prevent security issues.

l Apply settings to child processes: Ensure that child processes triggered by the rule will not fail
due to lack of privileges. This check box is enabled by default.

l User’s context will be used to resolve system and resource access: Ensure that the Client
uses the target's user environment to resolve file and registry access. This might be required to
resolve drive mappings, and also if the rule specifies the publisher, version, or file hash for the
target process running from a network location.

3. Define whether the rule will be user or computer-based.

l User Policy: Select this option to apply the rule to the user logged into the computer. This option
corresponds to the User Configuration node of the Group Policy Management Editor and is the
default policy for all editions of Privilege Manager for Windows.

l Computer Policy: Select this option to apply the rule to a computer irrespective of the user
logged in. This option corresponds to the Computer Configuration node of the Group Policy
Management Editor. Available only in Privilege Manager Professional and Professional
Evaluation editions.

4. Complete the Privileges (see Granting/denying privileges (Privilege Elevation Rules only)) and Integrity
(see Differentiating security levels (Privilege Elevation Rules only)) tabs to modify the rule.

5. Click Finish to quit the wizard.

6. The rule will be named after the installer file or patch.
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Creating rules for script files
Available only in Privilege Manager Professional and Professional Evaluation editions.

Use the By Path to Script File rule to elevate or decrease privileges for processes that start from a script file.

To create a By Path to Script File rule using the Create Rule Wizard:

1. Open the Create Rule Wizard. For more information, see Using the Create Rule Wizard on page 37.

2. Set the absolute or relative path to one of the following types of script files:

l Command Prompt: .cmd

l Batch File: .bat

l JavaScript: .js

l VBScript: .vbs

l PowerShell: .ps1

l Perl: .pl

Wildcards are supported and you can use the Browse button to locate the path.

3. Fill in these optional fields, as necessary:

l Publisher: Limit Elevation to files signed with the digital certificate of a publisher. Enter the exact

name or use the Browse button to locate it.

This field is not supported for .pl, .cmd, and .bat files.

l File Hash: Click the Browse button to locate the file and create a unique cryptographic hash
that limits Elevation to files that match it. This ensures that the rule will not apply to dangerous
content that is similarly named and will help prevent security issues.

l Apply settings to child processes: Ensure that child processes triggered by the rule will not fail
due to lack of privileges. This check box is enabled by default.

l User’s context will be used to resolve system and resource access: Ensure that the Client
uses the target's user environment to resolve file and registry access. This might be required to
resolve drive mappings, and also if the rule specifies the publisher, version, or file hash for the
target process running from a network location.

4. Define whether the rule will be user or computer-based.

l User Policy: Select this option to apply the rule to the user logged into the computer. This option
corresponds to the User Configuration node of the Group Policy Management Editor and is the
default policy for all editions of Privilege Manager for Windows.

l Computer Policy: Select this option to apply the rule to a computer irrespective of the user
logged in. This option corresponds to the Computer Configuration node of the Group Policy
Management Editor. Available only in Privilege Manager Professional and Professional
Evaluation editions.

5. Complete the Privileges (see Granting/denying privileges (Privilege Elevation Rules only)) and Integrity
(see Differentiating security levels (Privilege Elevation Rules only)) tabs to modify the rule.

6. Click Finish to quit the wizard.

7. The rule will be named after the script file.
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Using Active Directory user groups (Privilege
Elevation Rules only)
Use the Groups tab to add or remove an Active Directory user group from the security token of the target
process. Removing a group decreases the privileges with which the process will run.

To add or remove an Active Directory user group using the Groups tab in the Create
Rule Wizard:

1. If the Administrators group (stored within the BUILTIN\Administrators Active Directory OU) does not

appear on the list by default, click the button to add it.

l Select this group of users, who have complete and unrestricted access to a local computer,
instead of domain administrators.

l The button will not be active if the group is already on the list.

2. Use the button to add or remove other groups. When the window opens:

a. Use the Browse button to specify the group name.

b. Select add or remove.

3. To delete or modify a record within the Security Group list, select it and use the or button.

l You can only add security groups in Active Directory which have a group scope property
of Built-in local to the security token of a process on a client computer if the Client also
has the same security identifier definition (SID) in its built-in security groups.

l When removing a group from the security token, ensure that the user account under
which the process is launched is a member of more than one primary group. Otherwise,
the rule will not apply as intended.

Using Validation Logic
Available only in Privilege Manager Professional and Professional Evaluation editions.

By default, a rule will apply to all client computers to which the previously selected GPO is linked. For more
granular targeting, you can use the Standard Rules and Validation Logic Rules sub-tabs of the Validation Logic
tab in the Create Rule Wizard to target the rule based on the client’s operating system, their IP address, and/or a
logged-in user.

Using standard rules
Within the Standard Rules sub-tab in the Create Rule Wizard, you can set a rule to apply only to clients with
specified operating systems, servers, or workstations. By default, all operating systems are selected. If no
options are selected, then the rule will apply to all supported operating systems.
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To use the Standard Rules sub-tab in the Create Rule Wizard:

l Check the Server check box in the Class section to apply the rule to Windows Server 2008/2008
R2/2012/2012 R2.

l Check theWorkstation check box in the Class section to apply the rule to Windows 7/8.1/10.

l In the Operating System section, check the checkboxes for your operating systems.

Using Validation Logic rules
The Validation Logic Rules sub-tab in the Create Rule Wizard allows you to set additional parameters to target
the rule. You can define whether the rule will run on computers with a prefix in the name, a group or IP address
range, or a user currently logged in. For example, you can target the rule to computers belonging to OUs that
end with DEPARTMENT and are in subnet 192.168.0.X, except for the IP address 192.168.0.1.

Note: Client Deployment Settings can only be targeted to specific computers and not to user accounts or
groups.

Setting rule parameters

To set rule parameters using the Validation Logic Rules sub-tab in the Create Rule Wizard:

1. Click Add to open the Add Validation Logic Rule window.

2. Select the type of rule:

Type of Rule Action

Computer Group

Set a rule for one or several names, or partial names, of your Active Directory
computer groups. Enter the NetBIOS name, for example:

DERPA\DOMAIN CONTROLLERS

User Group

Set a rule for one or several names, or partial names, of your Active Directory user
groups. The group membership value you enter will be compared against the
groups that the user belongs to during the logon process and must match for the
configuration to be processed. Enter the NetBIOS name, for example:

DERPA\ADMINISTRATORS

User Name

Set a rule if specific users are logged into client computers. Enter the NetBIOS
name, for example:

DERPA\HELPDESK

OU (Computer)

Set a rule for names, or partial names, of computer-based OUs or the Computers
container in your Active Directory. The OU value you enter will be compared
against the OU the client computer belongs to during the logon process and must
match for the configuration to be processed. Enter the fully qualified domain name
(FQDN), for example:

DERPA.DERPADEV.LOCAL\DOMAIN CONTROLLERS
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Type of Rule Action

l To select OUs, check the OU checkboxes.

l To select all containers (instead of OUs), select the domain so that it is
highlighted.

l To include child objects, highlight the parent object and check Include
child objects.

OU (User)

Set a rule for names, or partial names, of the user-based OUs or the Users
container in your Active Directory. The OU value you enter will be compared
against the OU the user belongs to during the logon process and must match for
the configuration to be processed. Enter the FQDN, for example:

DERPA.DERPADEV.LOCAL\USER ACCOUNTS

l To select OUs, check the OU checkboxes.

l To select all containers (instead of OUs), select the domain so that it is
highlighted.

l To include child objects, highlight the parent object and check Include
child objects.

Computer Name

Set a rule for computers with names or partial names. Enter the FQDN, for
example:

DERPA.DERPADEV.LOCAL\PASERVER

IP Address Range
(v4/v6)

Set a rule for IP addresses or ranges of computers.

Registry Key Exists

Set a rule based on the registry keys on client computers.

File Exists

Set a rule for files on the client computer or on the network. Specify a file that must
exist on the client computer or on the network in order for the rule to run, for
example:

\\ComputerName\SharedFolder\Filename.exe

DriveLetter:\Filename.exe

Note: On the Type tab of the Create Rule Wizard, check the check box for
User’s context will be used to resolve system and resource access to
ensure that the rule will apply.

Define when a rule should start and/or stop being enforced.

a. Check the checkboxes before the date and/or time fields in the Date
Range/Time Range sections.
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Type of Rule Action

Date and Time Range b. Set the values.

c. The rule will apply according to the time/date parameters of the Console
used to create the rule.

3. Specify the rule's parameters in the dialog window that will display on the right:

ll Use the common asterisk (*) and question mark (?) wildcards in the validation value, as necessary.

l * : Stands for no or any number of any characters

l ? : Stands for a single character

l Check the NOT check box to exclude the items specified from the rule.

l For Computer Group, User Group, User Name, OU (Computer), OU

(User), and Computer Name:

a. Use the Name field to specify the rule's value manually (see example values in the table above),

and then click the button. Or,

b. Use the Browse button to select the items available on your network. You can filter the items
by the first letters. Wildcards are not supported in the Filter field.

c. The desired value will be added to the list. You may add as many rule values as necessary.

4. Click OK when you are finished specifying the settings within the rule type. The record will display in the
main Validation Logic Rules list.

5. To add another Validation Logic rule, repeat the steps above.

6. Add or combine Validation Logic rules with AND or OR Boolean logic. By default, rules will combine with
OR Boolean logic. To make the rule use the AND operator, select AND at the bottom of the Validation
Logic Rules window.

7. To edit a rule setting:

a. Within the Validation Logic Rules list, double-click a rule value or click the Edit button.

b. Make changes in the dialog.

8. When finished specifying Validation Logic rules, click Next. If the Display Advanced Options check box
has not been selected, complete the rule creation process.

Granting/denying privileges (Privilege Elevation
Rules only)
On the Privileges tab in the Create Rule Wizard you can grant or deny privileges for a process, based on the
standard Windows policies in the User Rights Assignment list (Local Security Settings\Local Policies).
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To apply/deny privileges for processes (including child processes) using the Privileges tab in the
Create Rule Wizard:

1. Select the privilege and click Grant or Deny. To select multiple privileges, hold down the CTRL (or
SHIFT) key while selecting the items.

2. To discard your choices, select the privilege and click Not Set.

Differentiating security levels (Privilege
Elevation Rules only)
You can differentiate the security levels with which a process will run using the Integrity tab in the Create Rule
Wizard. The integrity level is a feature of Windows operating systems beginning with Windows 7.
This parameter can be applied to clients running Windows Server 2008, Windows 7 and Windows Server 2008
R2 and Windows Server 2012, and Windows 8.1 and Windows Server 2012 R2, and Windows 10.
By default, this setting will not apply and is set to the High integrity level.

Managing rules
Once a rule is created, you can change its settings, delete, import and export it.

To delete, modify, or share a rule:

1. Use the applicable toolbar buttons.

To use the Edit Rule Wizard to configure a rule:

1. Select the Privilege Elevation Rules or Blacklist Rules tab based on the type of rule to be created.

2. Double-click a rule's title or click the Details button on the toolbar to open the Edit Rule Wizard.

3. Specify the data requested in each tab and click Next.

a. Follow the prompts through the default tabs: Description, Type,Groups, and Validation Logic
(available only for Privilege Manager Professional). The Privileges and Integrity tabs display as
advanced options.

b. Enter the required fields, marked with an asterisk '*' on the Description and Type tabs.

4. Click Finish to save and apply the rule. If you did not specified the required data, the wizard notifies you.

5. Click the Save button on the menu bar of the Rule section. Or, if prompted, confirm that you want to
save the rule.

More information for managing rules:

l To delete or modify a GPO created with Privilege Manager, use the Microsoft Group Policy Management
Console (GPMC). You can also edit rules using the GPMC. For more information, see Using the Group
Policy Management Editor on page 1
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l If you are using the Privilege Manager Community Edition and open a rule with a Privilege Manager
Professional feature to view or modify its settings, a notification appears. Click Yes to open the Edit Rule
window to display all the rule settings except for the Professional ones. Modifying the rule discards the
Professional features.

Import/Export Rules
Once rules are created for a GPO they can be exported in order to share the rules, copy the rules to another
GPO or even for backup purposes.

To export rules:

1. Select a GPO in the domain tree.

2. Right-click on the GPO name and select Export Rules.

3. Enter the path and file name of the export file to be created. Click ... to select a path using File Explorer.

4. In the pop-up window that displays a count of the Privilege Elevation Rules and Blacklist Rules for the
GPO, complete the following steps, as applicable:

l Select Export all Privilege Elevation Rules to include those rules in the export.

l Select Export all Blacklist Rules to include those rules in the export.

5. Click Export to begin the export process.

To import rules:

1. Select a GPO in the domain tree.

2. Right-click on the GPO name and select Import Rules.

3. Enter the path and file name of the file to be imported. Click ... to select a path using File Explorer.

4. In the pop-up window that displays a count of the Privilege Elevation Rules and Blacklist Rules for the
GPO, complete the following steps, as applicable:

l Select Import all Privilege Elevation Rules to include those rules in the import.

l Select Import all Blacklist Rules to include those rules in the import.

5. Click Import to begin the import process.

Testing rules
You can test a rule to ensure that the settings you specified map to a process on a local or remote computer.
You can test all types of rules, except ActiveX.

Before you test a rule, ensure the following components are set up:

1. The Client is running on the computer on which you intend to test the rule.

2. The remote computer is switched on and is accessible from the network.

3. The correct credentials to connect to the remote computer are provided.

4. The following exceptions are added for remote computers with a firewall turned on:
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l Windows Management Instrumentation (WMI): dllhost.exe

l Host process for Windows services: svchost.exe for 32-bit OS and
%SystemRoot%\SysWOW64\svchost.exe for 64-bit OS.

To test a rule:

1. Within the Group Policy Settings section, select a rule, and click the Test button.

2. Select whether to test the rule on a local or remote computer.
A test window appears and the test starts. The window displays the initial conditions necessary for the
rule to run and present its status in the Test Progress section, testing if:

l The connection with the target computer has been established;

l The Client is installed on your computer;

l The Group Policy update has run successfully on the client computer;

l The GPO with the selected rule is present on the domain; and

l The rule exists on the client side and on the domain.

3. If the test fails any of the steps, resolve the issue. If you encounter a Failed to retrieve processes.
Please refer to documentation for more info error, complete the steps above before you test the rule.

4. Click Next.

5. When the Detecting Process window opens, manually run the process the rule applies to. Use
the parameters specified in the Rule Details section of the Test File Rule window. The window
shows two tabs:

l The Started Processes tab with the processes started after you switched from the Detecting
Process window.

l The process that you start to test the will display with either a tick or a cross sign.

l If the process is marked with the cross sign, look at Process Details and check that you
started the process with the right parameters, or modify the rule settings.

l The All Processes tab with all currently running processes.

6. When the rule is created and distributed to clients through Group Policy, the rule is applied to the
corresponding process.
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Removing local admin rights
Using the Active Directory Users and Computers utility
Using the Users with Local Admin Rights screen

The last step in preparing your environment for least privileged use is to remove administrative access from
users who no longer require it.

Using the Active Directory Users and
Computers utility
Use the Windows utility Active Directory Users and Computers, installed on Windows Server operating
systems such as Windows 2008, to scrub the Domain Administrators group of users that should no longer be
given administrative rights to every computer in the domain. Select Domain Admins Properties > Members
tab > Remove.

Using the Users with Local Admin
Rights screen
Available only in Privilege Manager Professional and Professional Evaluation editions.

Under the Discovery & Remediation tab on the Console, select the Users with Local Admin Rights screen to
discover which domain users have been assigned to the local Administrators group on client computers and
remove them.

Before you begin, check the following on each target computer:

1. The computer is turned on and accessible from the network; and

2. Windows Management Instrumentation (WMI), Distributed Component Object Model (DCOM), File and
Printer Sharing, and Remote Administration are allowed through the firewall.
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To remove domain users from the local Administrators group on computers on your domain:

1. Within the Select Computers section, use the Add and Remove buttons to add and remove computers.

l You cannot select a domain controller computer.

l If the File and Printer Sharing exception is not enabled for a computer, it will not display in the list.

l If the Windows Management Instrumentation exception is not enabled, the Class and OS
columns will display the Unavailable value.

2. Click the Clear all entries button to remove all computers from the list.

3. Click the Discover Accounts in local Administrator groups button to discover users and domain
groups with local administrator rights. By default, the search results will only include domain users and
domain groups. However, you can optionally opt to include local and built-in (for informational purposes
only) users.

4. In the window that opens, specify whether to search for local Administrator groups, users, or both.

5. Check the Only display domain accounts discovered in the results list option to restrict the search to
Domain accounts only. Clear the option to include local accounts from the Administrators group on
client machines.
A window displays your progress as the list builds.

6. Complete the following steps:.

a. If an error occurs, it will display in the Errors section with a description. The Unable to open log
file... notification signifies that no users in the local Administrators group have been detected.

b. Click the Open report file button to view data on detected users. The button will not be activated
if no users have been found in the local Administrators group.

c. When the discovery operation is completed, click the Close button.

The list of discovered users will display in the User Accounts Discovered in Local Administrators
Groups section.

7. Revise the list to only include users you are potentially going to revoke rights from then make your final
selection from the remaining list.

a. Click the Exclude selected entries from list link to remove users from this list.

b. Select users from the remaining list, for which you want to revoke their local administrator rights.

c. Click the Remove all selected users from local Administrators groups button.

8. In the window that opens, click Yes to confirm that you want to remove the users or groups.
A window displays your progress as the users are removed.

9. Complete the following steps:

a. If an error occurs, it will display in the Errors section with a description.

b. Click the Open report file button to view the operation log.

10. When the operation is complete, the users no longer have local administrator rights.

Congratulations! You are now running in a least privileged use environment.
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Reporting
Elevation Activity Report
Blacklist Activity Report
Rule Deployment Report
Instant Elevation Report
Temporary Session Elevation Request Report
Temporary Session Elevation Usage Report
Rule Details Report
Advanced Policy Settings Report
Generating and using reports
Using the Applied Filters Wizard
Using the Scheduled Reports Details Wizard
Using the Resultant Set of Policy Wizard

Reporting is available only within the Professional edition; once a trial license expires, data is no longer being
collected and reports stop generating.

You can build five types of reports on activities from client computers:

l Blacklist Activity Report: Lists how frequently a rule is used.

l Rule Deployment Report: Lists rules deployed on the client computer.

l Instant Elevation Report: Lists processes that are elevated using Instant Elevation.

l Rule Details Report: Lists rules that are configured.

l Advanced Policy Settings Report: Lists Advanced Policy Settings, except those set to the Not
Configured option.

In addition to these out of the box reports, you can create custom reports using third party tools to query the
SQL-based Privilege Manager for Windows reporting database. Use this database schema to create your own
custom reports or data analysis:
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A PAReporting database is created when you set up the server and is configured to work with the ScriptLogic
PA Reporting Service, the data collection web service running on a Console host.

Before you generate reports, ensure the following components are set up:

1. The Server is configured and you can successfully join the data collection web service running on it.

2. Client data collection settings are configured for the GPOs you will report on. You can generate reports
on GPOs for which you have read/write access in Windows.

Elevation Activity Report
This report allows you to track which rules were used to elevate processes during a period of time on
managed client computers. With this report, you can see when users have run privileged processes and on
which computers.
Each privilege Elevation event reported contains these details:

l Type: The privilege Elevation rule type.

l Elevated Item: The path to the elevated application or command with the argument (if any).
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l Rule Name: The privilege Elevation rule name.

l Rule GUID: The privilege Elevation rule globally unique identifier (GUID).

l User (Domain\Name\OU): The user, domain name, and OU.

l Computer (Domain\Name\OU\Class\OS): The computer, domain name, OU, class, and OS.

l Elevation Time: The time of the privilege Elevation on the client computer.

To learn how to create this type of report and manage the data, see Generating and using reports.

Blacklist Activity Report
This report allows you to track which rules were used to Blacklist processes during a period of time on managed
client computers. With this report, you can see when users have attempted to run blacklisted processes and on
which computers.
Each Blacklist event reported contains these details:

l Type: The privilege Elevation rule type.

l Blacklisted Item: The path to the blacklisted application or command with the argument (if any).

l Rule Name: The privilege Elevation rule name.

l Rule GUID: The privilege Elevation rule globally unique identifier (GUID).

l User (Domain\Name\OU): The user, domain name, and OU.

l Computer (Domain\Name\OU\Class\OS): The computer, domain name, OU, class, and OS.

l Blacklisted Time: The time of the blacklisted event on the client computer.

To learn how to create this type of report and manage the data, see Generating and using reports.

Rule Deployment Report
This report tracks the overall usage of privilege Elevation rules across a domain. The report lists each rule,
showing how many clients it has been deployed to and how many times it is used.
Each record about a deployed rule contains these details:

l Rule Name: The privilege Elevation rule name.

l Rule GUID: The privilege Elevation rule globally unique identifier (GUID).

l For a Summary report:

l # Comp: The number of client computers on which the rule is deployed.

l # Used: The number of times the rule has been enforced.

l For a Details report:

l User (Domain\Name\OU): The user, domain name, and OU.

l Computer (Domain\Name\OU\Class\OS): The computer, domain name, OU, class, and OS.

l Deployed Date: The date the rule was deployed on the client computer.

To learn how to create this type of report and manage the data, see Generating and using reports.
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Instant Elevation Report
This report allows you to track Instant Elevation activity during a period of time on managed client
computers. With this report, you can see when users have been granted Instant Elevation privileges and on
which computers.
Each privilege Elevation event reported contains these details:

l Type: The privilege Elevation rule type.

l Elevated Item: The path to the elevated application or command with the argument (if any).

l Rule Name: The privilege Elevation rule name.

l Rule GUID: The privilege Elevation rule globally unique identifier (GUID).

l User (Domain\Name\OU): The user, domain name, and OU.

l Computer (Domain\Name\OU\Class\OS): The computer, domain name, OU, class, and OS.

l Elevation Time: The time of the privilege Elevation on the client computer.

To learn how to create this type of report and manage the data, see Generating and using reports.

Temporary Session Elevation Request
Report
This report allows you to track Temporary Session Elevation passcode requests from managed client
computers. With this report, you can see when a passcode has been generated based on a request, if the
request was denied, or if the request is still pending review.
The Temporary Session Elevation Request report contains these details:

l User (Domain\Name): The user that used the passcode on their machine.

l Action: The state of the Elevation request. This can be Pending (when a request is received),Granted
(when a passcode is generated for the request) or Denied ((when a passcode request is not granted).

l Processed Date: The date the administrator respondeds to the request.

l Reason: The reason given for the Elevation request.

l Maximum Allowed Usage: The number of times the passcode can be used before expiring.

l Duration: The amount of time the passcode remains active for when used.

l Computer (Domain\Name): The computer that the passcode is requested from.

l Request Sent: The date and time the user submits the request for a passcode.

To learn how to create this type of report and manage the data, see Generating and using reports.
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Temporary Session Elevation Usage
Report
This report allows you to track Temporary Session Elevation activity during a period of time on managed client
computers. With this report, you can see when users are granted temporary Instant Elevation privileges using
passcodes, on which computers, and also which specific applications were elevated.
The Temporary Session Elevation Usage report contains these details:

l User (Domain\Name): The user that used the passcode on their machine.

l Maximum Allowed Usage: The number of times the passcode can be used before expiring.

l Remaining Usage: The number of times that are left to use this passcode.

l Usage Count: The number of times this passcode is used so far.

l Elevated Item: The application that was run in an elevated state.

l Computer (Domain\Name): The computer that the passcode was used on.

l Time Elevated : The date and time the Elevation occurred.

l Passcode ID: The exact passcode provided by the administrator.

To learn how to create this type of report and manage the data, see Generating and using reports.

Rule Details Report
This report lists all the configuration details for a rule in a single view. The detail for each privilege
Elevation event are specified in the Create Rule Wizard. For more information, see Using the Create Rule
Wizard on page 37.
To learn how to create this type of report and manage the data, see Generating and using reports.

Advanced Policy Settings Report
This report lists all configuration details, except those set to the Not Configured option, of the Advanced Policy
Settings for your GPOs in a single view:

l Client Data Collection Settings

l Client Deployment Settings

l Self-Service Elevation Request Settings

l Privileged Application Discovery Settings

l Instant Elevation Settings

The details for each privilege Elevation event are specified in the corresponding section for each of the settings.
To learn how to create this type of report and manage the data, see Generating and using reports.
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Generating and using reports
To generate a report:

1. Under the Reporting section of the Console, select the type of report. The window for the report will open
to the right.

2. Click the Generate Report button to generate a report based on the default filter settings displayed in
the Applied Filters section on the top of the screen. You can create multiple shared filter sets and
save settings that other administrators can use. For more information, see Using the Applied Filters
Wizard on page 62.

3. Use the toolbar next to the Applied Filters drop-down menu to add, edit, copy, or
delete a filter.
The results appear below.

4. For the Rule Deployment report, use the Type and Sort menus to view additional information
and sort data.

5. Use the toolbar at the top of the results window to navigate the pages or organize them and
search for data.

6. To navigate across a multi–page report, use the and buttons.

7. The Number of Records field in the upper part of the results page refers to the number of rules listed in
the report.

To save the data, use either the Copy or Export To buttons on the results window:

1. Click anywhere on the results window.

2. Click the Copy button.

3. Paste the copied data into a file.

Or,

1. In the toolbar of the of the results window, click the Export To PDF, Export To Excel, Export To Html, or
Export To RTF button to save the data into a PDF, Excel, HTML, or RTF file.

2. In the Save As window that appears, name the report.

3. Click Save.
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Using the Applied Filters Wizard
To use the Applied Filters Wizard to modify displayed requests and save shared filters for other
administrators:

1. Open the Console and select the area for your shared filter set by completing one of the following steps:

l Under the Reporting section, open the screen for Elevation Activity, Rule Deployment, Instant
Elevations, Rule Details, or Advanced Policy Settings, or

l Under the Discovery and Remediation section, open the screen for Privileged Application
Discovery or Self-Service Elevation Requests.

The Applied Filters section appears on the top of the screen.

2. Use the toolbar next to the Applied Filters drop-down menu to add, edit, copy, or
delete a filter.
The Applied Filters Wizard appears when you add a filter.

3. Complete the following steps:.

a. Enter a name for your filter set.

b. Select a filter type in the left section.

c. Set the desired parameters in the right section.

d. Press Reset to reset to the default screen, OK to save your settings, or Cancel to
close the screen.

4. You can create multiple shared filter sets and save settings that other administrators can use.

When you select a filter type, it is saved automatically and you can proceed to another modification.
Select as many filter types as necessary by switching between them and configuring settings.

NOTE: Each filter type can have only one value specified. Every time you set a
new value for the same filter type, the newer one overwrites the older one.

5. When finished, click OK to save your changes.
The specified filter values appear in the Applied Filters list.

Using the Scheduled Reports Details
Wizard
After you create a shared filter set to modify your report criteria, you can select a report and set its schedule and
delivery. You can configure it to go to multiple recipients, including you, your manager, and/or the help desk. In
addition, you can set the subject line to meet the requirements of your help desk. You can also specify network
and file share locations to send it to.
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To use the Scheduled Reports Details Wizard to generate a scheduled report:

1. Configure the Server.

a. Use the Privilege Manager Server SetupWizard to configure the Server Email Notification
Configuration settings on the first screen of the wizard.

b. If you previously completed the wizard, the remaining screens are automatically populated.

c. Refer to the Privilege Manager for Windows Quick Start Guide for step-by-step instructions.

2. Create shared filter sets to modify your report criteria. You must create at least one shared filter set to
generate a scheduled report. Scheduled reports work only for shared filter sets configured in the
Reporting tab (except for the built-in Local Filters), not in Discovery & Remediation. For more
information, see Using the Applied Filters Wizard on page 62.

3. In the Reporting section of the navigation pane, select Scheduled Reports.

The Scheduled Reports section appears on the top of the screen.

4. Complete the following steps:

a. Click the Refresh button to refresh the screen and update the last run time.

b. Use the toolbar to add, edit, copy, or delete a report.

5. The Scheduled Reports Details Wizard will open when you add a report.

6. Complete the Type tab and click Next.

7. Complete the Schedule tab.

a. Select the Start time.

b. Select the Cycle for how often the report will run. Changes to scheduled reports may take up to
10 minutes to take effect.

c. Click Next.

8. Complete one of the sub-tabs under the Delivery tab.

a. Complete the Email sub-tab.

i. Use the button to add email addresses and the button to remove them.

ii. Enter a subject.

iii. Select the report format.

Or,

b. Complete the File share sub-tab.

i. Type the folder path in the following format: \\ComputerName\SharedFolder

ii. Use the Browse button to locate the folder.

iii. Use the button to add folder paths and the button to remove them.

iv. Select the report format.

9. Click Finish.

10. After the report is created, check your email or file share to confirm receipt.
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Using the Resultant Set of Policy
Wizard
The Resultant Set of Policy (RSoP) Wizard is a built-in MMC snap in. It helps you view policy settings applied to
selected computers and users (in the logging mode) or simulate a policy implementation to plan changes to
your network (in the planning mode). On Windows 10 machines .Net 4.0 needs to be enabled or the PM
Console installed in order to view the values from the RSoP Wizard.

To use the Resultant Set of Policy Wizard to report on policies you have applied:

1. Install the Client on the computer for which you are viewing or simulating a policy.

2. Open the MMC. On the Start menu, click Run, type MMC, and then click OK.

3. From the File menu, select Add/Remove Snap-in. The Add or Remove Snap-ins dialog box appears.

a. Select Resultant Set of Policy under the list of snap-ins.

b. Click the Add button.

c. Click OK.

4. The Console Root window now has a snap-in, Resultant Set of Policy, rooted at the Console
Root folder.

5. Under the Name column, click Resultant Set of Policy.

6. Complete one of the following steps:

l Right-click Resultant Set of Policy and selectGenerate RSoP Data

l Under the Resultant Set of Policy pane in the Actions column, click More Actions and select
Generate RSoP Data.

The Resultant Set of Policy Wizard appears.

7. Complete the following steps:

a. Choose the Logging mode to review policy settings or the Planning mode to simulate a policy
implementation.

b. Specify the data requested in each tab and click Next.

c. Click Finish to quit the wizard.

The Console Root window now has Privilege Manager for Windows nodes, rooted at the Console Root
folder under Computer Configuration and User Configuration. Privilege Manager for Windows
Details appears on the right, showing the rules and advanced policy settings that are applied.
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Client-side UI customization
Privilege Manager supports the text customization of all user-facing dialogs on client computers. In addition to
the ability to change the default English dialog text, admins can also create client-side UI customization files for
any non-English client language locale.

Language translation fFiles
To customize the language used in the client-side UI, one or more translation files must be located in the same
folder where the client files are installed, by default: C:\Program Files (x86)\Common Files\Quest\Privilege
Manager\Client.
A language-specific translation file must be named as follows: <two_letter_language_code>-pmlang.ini
Example:

l Spanish translation language file name: es-pmlang.ini

l English translation language file name: en-pmlang.ini (used to customize client computers with
English locale)

l French translation language file name: fr-pmlang.ini

NOTE: The en-pmlang.ini file is present in the client folder by default. If no language translation file
exists, default English UI text is used. Please see Privilege Manager for Windows KB 266054 for
information on language translation files currently available for download, as well as configuration and
troubleshooting tips.

Privilege Manager automatically searches for the language translation file corresponding to the language locale
setting on a client computer. If no translation file is found, default English client-side text strings are used.
A specific language translation file can be used regardless of the Window's local setting,s with the use of a
registry setting.

l Hive: HKCU\Software\Scriptlogic Corporation\Privilege Authority

l Key: Preferred Language

l Type: REG_SZ

l Value: name of language file; for example: es-pmlang.ini

The corresponding translation file must exist as described above.
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In addition to checking locally on the client computer for language translation files, the Privilege Manager Client
automatically copies down (and overwrites existing, if older) language files found on the NETLOGON share.

NOTE: NETLOGON is checked for updated language files every time a user logs on to a computer.
Additionally, Administrators can configure the Privilege Manager Client to check an alternate location for
updated language translation files. This can be done by updating the TranslationFilesFolder value
in HKLM\Software\Scriptlogic Corporation\Privilege Authority.
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Using Microsoft tools
You can use Microsoft tools with Privilege Manager for Windows to:

l Install the Client using the Group Policy Management Console. For more information, see Using the
Group Policy Management Console on page 14.

l Create and manage rules using the Group Policy Management Editor in the Group Policy Management
Console. For more information, see Using the Group Policy Management Editor on page 36.

l Remove local administrator rights using the Active Directory Users and Computers Utility. For more
information, see Using the Active Directory Users and Computers utility on page 54.

l Report on policies you have applied using the Resultant Set of Policy Wizard. For more information, see
Using the Resultant Set of Policy Wizard on page 64.

Privilege Manager for Windows 4.4 Administrator Guide
Using Microsoft tools

67



13

Maintaining a least privileged use
environment

Processing Self-Service Elevation Requests
Using Group Policy Settings

Maintain a least privileged use environment by processing Self-Service Elevation requests, using the Console
Email Configuration screen, and using group policy settings.

Processing Self-Service Elevation
Requests
Monitor and process Self-Service requests from users using Self-Service Notifications and the Self-Service
Elevation Requests screen under the Discovery & Remediation tab. You can approve or deny requests for
access to run privileged applications. If approved, an Elevation rule is automatically generated for each request.
For more information, see Using Self-Service Notifications on page 25 and Using the Self-Service Elevation
Request Processing Wizard on page 26.

Using the Console Email Configuration screen
If you want Privilege Manager to send an email message to the user after approving or denying their Self-
Service Elevation request, you can configure the settings using the Console Email Configuration screen found
under Setup Tasks. For more information, see Using the Console Email Configuration screen on page 27.

Using Group Policy Settings
Use the Group Policy Settings screens to create custom Elevation rules or modify existing ones for your
environment. The Advanced Policy Settings tab can also be used to modify the settings for advanced features
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at the GPO level. These features include Client deployment settings, Client data collection settings, Instant
Elevation settings, Self-Service Elevation request settings, and privileged application discovery settings.
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Database Planning
The goal of this topic is to proactively manage disk capacity as it relates to Privilege Manager. The capacity
planning information provided here contains steps to help understand, install, and configure the Privilege
Manager database environment.
Eighty percent of database issues deal with disk capacity problems and in many cases, they are caused by
failure to adhere to best practices. Failure to adhere to best practices should never happen as these issues are
very predictable and could be prevented with a comprehensive database plan.
This section gives you a breakdown of the Privilege Manager database structure to better understand the
database environment and walks through capacity planning best practices to minimize the risk of disk over-
utilization.

Privilege Manager for Windows 4.4 Administrator Guide
Database Planning

70



Privilege Manager Database Diagram

Privilege Manager Tables
Table Name Description

Activity Contains rule and Instant Elevation activity; includes Elevation type and
item.

Computer Contains client computer information such as its name, domain, class, OU,
operating system and the version of Privilege Manager installed.

DatabaseVersion Contains the database version of the Privilege Manager database.

DataError Contains database exceptions and includes exception messages, host
address, host name and the XML data document that caused the
exception.

DeployedRules Every time a new rule is deployed, a record is created for every user
associated with this rule. This keeps track of all deployed rules, giving them
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a status of active or inactive and tracks date added or removed.

Discovery Contains information on any process that starts or fails to start on a client
computer. Data stored here includes the product name and requested
execution level. It is used by the Privileged Application Discovery
component.

Domain Contains records of the network domains.

ElevationRequest Contains Elevation requests made on the client, including information
about the name of products the request is being made for and the reason
for the request.

Reports_Scheduled Contains records of the scheduled reports to be generated.

SharedFilters All shared filters created.

Rules Rules created and saved in the Privilege Manager Console.

Users Users who have logged into a Privilege Manager Client machine.

Data Storage Estimates

Table Name # Rows Byte Size per Row Total Size (bytes)

Activity 1,000 4,222.68 422,268.00

Computer 1 84.38 84.38

DatabaseVersion 1 72.09 72.09

DataError 20 8,834.25 176,685.00

DeployedRules 20 49.15 983

Discovery 30 3,8049.23 1,141,476.9

Domain 1 84.38 84.38

ElevationRequest 20 54,540.61 1,090,812.2

Reports_Scheduled 10 4,575.25 45,752.50

Reports_SharedFiles 10 9,436.70 94,367.0

Rule 20 304.99 6,099.8

User 1 4,443.48 4,443.48

Total Size 4,683,128.73 Bytes

Table 1: Table size estimate for 1 Privilege Manager user.

As the number of users grow, some tablesincrease in size more rapidly than others. For this reason, the
database size does not grow proportionately.
Database size calculation uses the following rules:
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1. The Activity table generates one thousand records per user.

2. The number of Computer records are equal to the number of user records.

3. 20 reports represent one user.

4. The DatabaseVersion table should be one record irrespective of the number of user in the
environment.

5. The DataError table is estimated to be twenty records to one user.

6. The DeployedRules table should generate twenty records per one user.

7. The Discovery table should generate roughly thirty records per user.

8. The number of Domain table records are set to one per user.

9. Twenty ElevationRequest records are generated per user.

10. There are ten Reports_Scheduled records per user.

11. There are ten Reports_SharedFilters per user.

12. Twenty Rule records are generated per user.

13. One user record exists in the User table per user.

Privilege Manager Users Privilege Manager Database

1 4.7 MB

10 10.5 MB

100 73.0 MB

1,000 692.6 MB

2,000 1,378.6 MB

5,000 3,439.9 MB

10,000 6,876.4 MB

15,000 10,313.0 MB

20,000 13,749.5 MB

50,000 34,368.8 MB

100,000 68,734.2 MB

Table 2: Database size for multiple users.

Database hardware and software requirements
It is recommended that databases above 6876.4 MB or 10,000 u,sers (Table 2 displays the database size as it
relates to the number of users in the database environment) install the full SQL Server version. Any database
size below 6,000 MB should be adequate to run SQL Server Express with room to grow before an upgrade to
the full version of SQL Server is required.

NOTE: SQL Server Express databases have a size capacity limit of 10,000 MB.
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When it comes to computing capacity and maximum memory there is also a bottleneck where different SQL
Server installs may not be able to take advantage of processing power and large memory storage.

Enterprise Standard Web Express

Maximum database
size

524 PB 524 PB 524 PB 10 GB

Compute Capacity OS Max 4 sockets or 24
cores

4 sockets or 16
cores

1 socket or 4
cores

Maximum Memory OS Max 128 GB 64 GB 1 GB

Table 3: Maximum database size, compute capacity, and maximum memory of different SQL Server
installs.

Privilege Manager
Users

Privilege
Manager
Database

Recommended
SQL Server
Install

1 4.7 MB SQL Server
Express

10 10.5 MB SQL Server
Express

100 73.0 MB SQL Server
Express

1,000 692.6 MB SQL Server
Express

2,000 1,378.6
MB

SQL Server
Express

5,000 3,439.9
MB

SQL Server
Express

10,000 6,876.4
MB

SQL Server
Express

15,000 10,313.0
MB

SQL Server

20,000 13,749.5
MB

SQL Server

50,000 34,368.8
MB

SQL Server

100,000 68,734.2
MB

SQL Server

Table 4: Recommended SQL Server Installs for different
size Privilege Manager environments
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Auto-Growth
Privilege Manager uses the default auto-growth configuration settings that comes installed on SQL Server. This
setting sets the initial database size of SQL Server to 3 MB, then grows it by 1MB every time the data limit is
exceeded. The log file starts at 2 MB and is set to grow by 10% increments until the disk is full.
Even though the default auto-growth configuration settings work for Privilege Manager, it may not be the most
appropriate configuration for all environments (especially for customers exceeding 10,000 users).
Every time the database grows it takes a performance hit. In SQL Server storage terms, 1024 K is 128 pages;
pages are stored in 8 K blocks. For Privilege Manager, which is going to potentially load millions of records,
growing the data file of a database every 128 pages incurs a large performance hit, especially since SQL
Server’s I/O requests are a major bottleneck.
Additionally, since auto-growth allocates chunks of data at a time it is easier for the database to become
fragmented. With that in mind it is recommended to update the auto-growth settings.
The table below displays the recommended settings based on the size of the network environment. These
values are not set in stone but are based on database growth rates of your specific environment. The rule of
thumb is to set this value to one eight of the estimated database size. Ideally you should use auto-grow as a
fail/safe parameter, and use alerts or monitoring programs to monitor file sizes and grow files proactively. This
helps you avoid fragmentation and permits you to shift these maintenance activities to non-peak hours.

Privilege Manager
Users

Privilege
Manager
Database

Auto-growth

1 4.7 MB 1 MB

10 10.5 MB 1.3 MB

100 73.0 MB 9.1 MB

1,000 692.6 MB 86.5 MB

2,000 1,378.6
MB

172.3 MB

5,000 3,439.9
MB

429.9 MB

10,000 6,876.4
MB

859.5 MB

15,000 10,313.0
MB

1289.1 MB

20,000 13,749.5
MB

1718.7 MB

50,000 34,368.8
MB

4296.1 MB

100,000 68,734.2
MB

8591.8 MB

Table 5: Auto-growth recommendation for different size
Privilege Manager environment.
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How to change auto-growth on SQL Server
2014

NOTE: Steps may be slightly different for other supported versions of SQL Server.

To change the auto-growth settings:

1. Start SQL Server Management Studio.

2. Highlight, then right click the PAReporting database and navigate to Properties.

3. In the left Panel, select Files from the Database Properties dialog. The Properties window will be used to
change Auto-growth.

4. Identify the PAReporting name under Logical Name and change the Auto-growth based on table 5
above. In this example, we have set the auto-growth to 430MB and a max size of unlimited and left the
log file to grow my 10% to a limit of 20971252MB. 430 is roughly one eighth of the 3,439.9MB database
size for the 5000-user environment.

Initial database size
When Privilege Manager is installed it uses the default file and log size specified by SQL Server. The specified
file size is 3MB for the database and 2MB for the database logs. As these files fill up and exceed the initial file
size there are performance implications from growing this file and fragmentation of the data on the disk.
To prevent these performance issues, it is recommended that if the database is expected to grow to a specific
size in a month double that value and use it for the initial size. For example, if the database is expected to grow
to 2000Mb in a month, set the initial database size to 4000Mb. This will reduce the number of auto-growths and
lessen fragmentation because a larger allocation means more database related information can be accessed
from the same disk location. Table 6 below breaks down the recommended initial size for the database based
on a range of 1 to 100,000 users for the different database size estimates.

Privilege Manager
Users

Privilege
Manager
Database

Initial Size

1 4.7 MB 9.4 MB

10 10.5 MB 21.0 MB

100 73.0 MB 146.0 MB

1,000 692.6 MB 1385.2 MB

2,000 1,378.6
MB

2,757.2 MB

5,000 3,439.9
MB

6,879.8 MB

10,000 6,876.4 13,752.8 MB

Table 6: Initial Size recommendation for different size
Privilege Manager environment.
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Privilege Manager
Users

Privilege
Manager
Database

Initial Size

MB

15,000 10,313.0
MB

21,626.0 MB

20,000 13,749.5
MB

27,498.0 MB

50,000 34,368.8
MB

68,736.0 MB

100,000 68,734.2
MB

137,468.4 MB

How to change the Initial Size on SQL Server
2014

NOTE: Steps may be slightly different for other supported versions of SQL Server.

To change the Initial Size settings:

1. Start SQL Server Management Studio.

2. Highlight, then right click the PAReporting database and navigate to Properties.

3. In the left panel, select Files from the Database Properties dialog box. Use the Properties window to
change the Initial Size.

4. Identify the PAReporting name under Logical Name and change the Initial Size based on Table 5
above.
For example, you can set the Initial Size (MB) to 13,752.8MB. This value is two times the size of
the database.
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15

Product Improvement Program
To assist in the development of new features, as well as drive future improvements, we implemented a Product
Improvement Program. Feedback from this program provides Product Management with valuable insight into
how our products are being used. This information is essential to help the R&D team prioritize existing
enhancement requests within the roadmap of the each product. Participation is voluntary, and no personal
contact information is ever collected.

How do I participate in the Product Improvement Program?
What if I change my mind?
There is an option in Privilege Manager that can be used to verify or change your participation at any time.
Select the Helpmenu and then click on Product Improvement Program to change your participation option.

How will the collected information be used?
Information collected will be used to develop new features and improve Privilege Manager.

Where is the data being stored?
The data is stored on a secure server within the USA and will be accessed only be the members of the Privilege
Manager R&D team.

What information is collected?
l Privilege Manager features usage data such as Console configuration settings

l System information such as operating system, processor, and memory installed

l Domain information such as number of users, servers, and workstations being managed

l Browser type and version

l Product information such as version

l License information such as type and number of seats
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NOTE: The General Data Protection Regulation (GDPR) and California Consumer Privacy Act (CCPA)
define a set of data protection and security measures that restrict access to personally identifiable
information (PII). The Privilege Manager Client collects user-specific data from managed devices, and
sends it to the Server. This information is not shared with Quest. The only exception are domain names
associated with users who ran the elevated or Blacklisted process.

How does the Product Improvement Program work?
You choose to participate and allow Privilege Manager to send usage data, associated with an anonymous
user ID from your computer. If you are offline at any time, the data will be sent the next time an internet
connection is available.

How long will collected data be stored?
We will store the collected data on our secure server for as long as the Product Improvement Program
is in place.

Will I receive spam if I participate in the Product
Improvement Program?
You will not receive any e-mail regarding the Product Improvement Program, regardless of whether you
participate. We do not collect personally identifiable information.

Do I need an Internet connection?
An Internet connection is required for participation. However, it can be an intermittent connection. When an
internet connection becomes available, the information is automatically transmitted with minimal impact to
your system.

Can I see the data that is collected before it is transmitted?
No, the information cannot be displayed on the customer side. The collection of the desired data occurs
seamlessly in the background without affecting the product. Additionally, all formatting and processing of the
collected data are done post transmission.

How long will my participation in the program last?
Information is actively collected as long as you use the product version for which you have agreed to participate
or until you decide to end your participation.

How is my privacy protected?
We take many precautions in protecting the information that is collected and transmitted. You can learn more
about how we handle user information by reviewing our Privacy Policy.
Since no personally identifiable information is collected, the anonymous data will not be meaningful to anyone
outside of our company.
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About us
About us

Quest provides software solutions for the rapidly-changing world of enterprise IT. We help simplify the
challenges caused by data explosion, cloud expansion, hybrid datacenters, security threats, and regulatory
requirements. We are a global provider to 130,000 companies across 100 countries, including 95% of the
Fortune 500 and 90% of the Global 1000. Since 1987, we have built a portfolio of solutions that now includes
database management, data protection, identity and access management, Microsoft platform management, and
unified endpoint management. With Quest, organizations spend less time on IT administration and more time on
business innovation. For more information, visit www.quest.com.

Technical support resources
Technical support is available to Quest customers with a valid maintenance contract and customers who have
trial versions. You can access the Quest Support Portal at https://support.quest.com.
The Support Portal provides self-help tools you can use to solve problems quickly and independently, 24 hours
a day, 365 days a year. The Support Portal enables you to:

l Submit and manage a Service Request

l View Knowledge Base articles

l Sign up for product notifications

l Download software and technical documentation

l View how-to-videos

l Engage in community discussions

l Chat with support engineers online

l View services to assist you with your product
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